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Copyright

© 2022 Audinate Pty Ltd. All Rights Reserved.
Audinate®, the Audinate logo and Dante® are registered trademarks of Audinate Pty Ltd.
All other trademarks are the property of their respective owners.

Audinate products are protected by one or more of US Patents 7747725, 8005939, 7978696, 8171152,
European Patent 2255541, Chinese Patent ZL200780026677.0, and other patents pending or issued.
See www.audinate.com/patents.

Legal Notice and Disclaimer

Audinate retains ownership of all intellectual property in this document.

The information and materials presented in this document are provided as an information source only.
While effort has been made to ensure the accuracy and completeness of the information, no guarantee
is given nor responsibility taken by Audinate for errors or omissions in the data.

Audinate is not liable for any loss or damage that may be suffered or incurred in any way as a result of
acting on information in this document. The information is provided solely on the basis that readers will
be responsible for making their own assessment, and are advised to verify all relevant representation,
statements and information with their own professional advisers.

Software Licensing Notice

Audinate distributes products which are covered by Audinate license agreements and third-party license
agreements.

For further information and to access copies of each of these licenses, please visit our website:

www.audinate.com/software-licensing-notice
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About Audinate

Audinate® is the leading provider of professional digital audio networking technologies globally.
Audinate's Dante® platform distributes digital audio signals over computer networks, and is designed to
bring the benefits of IT networking to the professional AV industry. Using Dante-enabled products
ensures interoperability between audio devices and allows end users to enjoy high quality, flexible
solutions — typically with a lower total cost of ownership.

About Dante

Dante is the de facto standard digital media networking solution, using standard IP infrastructure to
network devices, and making interoperability easy and reliable. It distributes uncompressed, multi-
channel digital media via standard Ethernet networks, with near-zero latency and perfect
synchronization.

It's the most economical, versatile, and easy-to-use media networking solution, and is scalable from
simple installations to large-capacity networks running thousands of channels. Dante can replace
multiple analog or multicore cables with a single affordable Ethernet cable to transmit high-quality multi-
channel media safely and reliably. With Dante software, the network can be easily expanded and
reconfigured with just a few mouse clicks. Dante technology powers products available from hundreds
of partners around the world.

For more information, please visit the Audinate website at www.audinate.com.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -12-


http://www.audinate.com/

Dante Controller User Guide /ﬁi Ud i nate®

Introduction

About Dante Controller

Dante Controller is a software application provided by Audinate which

allows users to configure and route audio and video around Dante
networks. It is available for Windows and macOS (see Minimum System
Requirements for more details).

Once you install Dante Controller on your PC or Mac and connectitto a
Dante network, you can use Dante Controller to:

View all Dante-enabled audio and video devices and their channels
on the network

View Dante-enabled device clock and network settings

Route audio and video on these devices, and view the state of exist-
ing audio and video routes

Route ancillary channels for AV devices
Connect to Dante Domain Manager and control enrolled devices
Lock and unlock Dante devices
Rename device channels from numbers to names that suit you
Customize the receive latency (latency before play out)
Save audio and video routing presets
Apply previously saved presets
Edit presets offline, and apply as configurations for new network deployments
View and set per-device configuration options, including:
° Changing the device name
° Changing sample rate and clock settings
° Viewing detailed network information
° Access the device web page to upgrade firmware and license information (where supported)
° ldentify a device for example by flashing LEDs (where supported)
View network status information, including:
° Multicast bandwidth across the network
° Transmit and receive bandwidth for each device
View device performance information, including latency statistics and packet errors

View clock status information for each device, including frequency offset history and clock event
logs

Transmit and subscribe to AES67 RTP multicast audio flows, and SMPTE ST 2110-30
RTP multicast audio flows (DDM networks only)

Configure AV devices via custom control interfaces

The Dante Controller installation package also installs Dante Updater and Dante Activator.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -13-
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What's New
v4.5.0

® Dante Activator is now installed with Dante Controller

o Dante Activator is a new application that allows you to purchase and activate additional Dante
channels for supporting Dante Ready™ devices.

= Support for Windows 11
= New Domain Manager Login dialog (combines the DDM user and DDM server login functions)

= New feature: Connect Devices to Domain Manager (for DDM networks)

v4.4.0
= Support for Apple M1 architecture

= Native support for 64-bit Windows
° 32-bit Windows is no longer supported
= New user guide content: Resolution and Timing for Dante AV Devices

v4.3.3

= Support for Dante AV (video) devices. For more information, see:
° Routing for Video Devices
° Plugins
= New signal status icons for video and ancillary channels (Receive Tab and Transmit Tab)
= The Advanced Filter has been updated:
° The Subscriptions filter now includes extra options
° The Latency and Sample Rate filter options are now dynamic based on product type
° New filters have been added for Media Type, Video Subtype, and Ancillary Type

= Channel labels have been deprecated - all channel names are now user-editable (Device and
Channel Names)

= |nclusive language changes to clocking terminology:

° Some of the terminology used in Dante products has been changed to align with modern
usage. Specifically, areas related to Dante clocking now refer to “Primary Leader Clock”,
“Leader Clocks” and “Follower Clocks” to describe the functions of each role more clearly.

= Support for macOS 11 Big Sur

For more information about new features, please see the Dante Controller release pages at
audinate.com.

Previous releases

v4.2.5
Support for macOS 10.15.

v4.2.x

= Dante Updater is now installed with Dante Controller. For more information, see the Dante
Updater user guide.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -14-
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= Dante Controller now notifies the user when new firmware is available for a discovered device

= Dante Controller now collects anonymous usage data. To disable data collection, go to Help > Ana-
lytics.

= Support for multicast flows with more than 8 channels (supporting devices only)
= Support for SMPTE ST 2110-30 RTP audio flows (DDM networks and supporting devices only)*

= Support for AES67 RTP audio flows for enrolled devices (DDM networks and supporting devices
only)*

= For supporting devices, AES67 mode can now be toggled on/off without a device reboot

= When first connecting to a DDM server, Dante Controller will display the unique fingerprint for the
server. This security mechanism enables you to verify that the DDM server at the specified server
name / IP address is the server to which you actually intended to connect. See Viewing Domains
in Dante Controller for more information.

* Requires DDM v1.1 and device firmware v4.2

v4.1.1 (macOS)
Support for macOS 10.14.

v4.1.0

For devices with configurable audio controls (such as Dante AVIO adapters), the Device View now
includes a Controls tab.

v4.0.6

= Dante Controller can now connect to Dante Domain Manager, enabling you to control enrolled
devices

= Support for legacy devices in domains

= Support for audio routing between domains

= |mproved device status information for DDM networks

= Additional version information provided in the Device Info tab and the Device View > Status tab

Minimum System Requirements

The tables below list the minimum system specifications for your computer to be able to use Dante
Controller.

Disclaimer: It is possible that your computer may meet the requirements below, but suffer from some
other individual performance limitation related to its particular hardware. Please seek the advice of your
computer support administrator.

General

Component Recommended Minimum Requirement

Processor 1GHz or better

Memory 512Mbyte of RAM

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -15-
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Component Recommended Minimum Requirement
Network Standard wired Ethernet network interface (100Mbps or Gigabit) or wireless LAN
(Wi-Fi) interface
Windows
Component Recommended Minimum Requirement
Operating Windows 10 and 11
System NOTE: Both UTF-8 and Unicode are supported EXCEPT for host or device
names; the DNS standard does not support Unicode for these
macOS
Component Recommended Minimum Requirement

Operating System macOS 10.15, 11 and 12

Operating System Updates

Ensure your PC or Mac has the latest Windows or Apple updates installed.

Firewall Configuration

Firewall configuration for Windows Firewall and macOS built-in firewall is automatically handled during

installation.

If you are using a third-party firewall product, please refer to this Audinate FAQ for more information

about Dante ports.

Copyright © 2022 Audinate Pty Ltd. All rights reserved.
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Installing Dante Controller

Downloading Dante Controller

Dante Controller is available for download from Audinate’s website.
To download a copy of Dante Controller:

Go to the Audinate website: www.audinate.com.

1.
2. Navigate to Products > Dante Controller.

3. Under ‘Download’, choose your operating system.
4,

Click the red download button.

This will take you to the appropriate Dante Controller release page for your operating system.

Click the link under ‘File downloads’ to download the Dante Controller installer.

Installing Dante Controller on Windows

Once you have downloaded the self-installing Dante Controller file, navigate to the directory where you
have downloaded it (e.g. Desktop).

To install:
Ensure you are logged on to your PC as an administrator.
Navigate to and double-click the Dante Controller installer file.

Read the license agreement. If you agree to the terms, select the 'l agree' checkbox and click
Install. If you do not agree to the terms, click Close.

4. Confirm/acknowledge any Windows security prompts that are displayed.

Dante Controller will then be installed. Dante Controller will be added to the start menu, under
'Audinate’.

0 Note: Dante Updater will also be installed automatically.

Installing Dante Controller on macOS

To install Dante Controller on macOS:

1. Double-click the Dante Controller .dmg file. A drive icon will appear on your Desktop Finder win-
dow. Double click on this to open.

Doubile click the Dante Controller .pkg. This will run the installer.

Read the license text, and if you accept the terms of the agreement, click Agree.

If you do not accept these terms, click Disagree to terminate the installation.

0 Note: Dante Updater will also be installed automatically.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -17-
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Updating Dante Controller

Dante Controller can be updated directly from the application itself.

0 Note: Requires an active Internet connection.

Checking for Updates Manually

In Windows:
From the Help menu, select 'Check for Updates'.
In macOS:

From the Dante Controller application menu, select 'Check for Updates'.

Checking for Updates Automatically

Dante Controller can also check for updates automatically. If an update becomes available, you will be
notified via a pop-up message.

To activate automatic checking, in the update dialog, select the option to check for updates
automatically.

Uninstalling Dante Controller

You should not need to uninstall Dante Controller before installing a new version.

However, if you do wish to uninstall Dante Controller:

Windows

Navigate to Control Panel > Programs and Features, select Dante Controller and click Uninstall.

0 Note: Two other Dante features, 'Dante Control and Monitoring' and 'Dante Discovery', may still be
present in the programs list after uninstalling Dante Controller. Do not uninstall these features if
they are present - they are required by other Dante software applications (for example, Dante

Virtual Soundcard, Dante Updater, and third-party Dante control applications). They will be
removed automatically if they are no longer required.

macOS

Use the Uninstall tool available in the .dmg file.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -18-
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Dante Basics

Discovery and auto-configuration

When a Dante-enabled device is connected to an IP/Ethernet network, it will automatically:
1. Configure its IP address
2. Advertise itself to allow automatic discovery

Within seconds of a Dante-enabled device connecting to a network, Dante Controller will automatically
discover and display the device, allowing you to configure channels and route media.

Automatic network configuration
A Dante-enabled device connected to a network will automatically setup its own network configuration,
including its IP address.

If the network has a DHCP server, which may be the case for installed networks, it will receive its IP
configuration using the standard DHCP protocol.

On a network without a DHCP server, which may be the case for temporary or smaller networks, the
Dante-enabled device will automatically assign itself an address using link local protocols, in the same
way PCs and printers often do.

Automatic discovery
A Dante-enabled device will advertise information about itself to other Dante devices and Dante
Controller, including:
® Device name
B Channel names
= Number of channels
= Sample rates and bit depths
This information can be seen when viewing a device on Dante Controller, and allows Dante devices to

determine compatibility with other devices, such as compatible sample rates to allow media to be
routed.

Device Channels

A Dante device has a number of channels associated with it. These are either transmit (Tx) or receive
(Rx) channels. Receive channels and devices are listed down the left side of the grid. Transmit channels
and devices are listed along the top of the grid.

Transmit channels are advertised on the network. A receiver uses this advertisement to establish a
subscription to the channel. A transmit channel can be sent to multiple receivers using unicast or
multicast.

0 Note: Ancillary channels on AV devices cannot be sent via multicast.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -19-
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Receive channels are connected to transmit channels via a subscription. Each receive channel will
receive media over the network from at most one transmit channel.

Subscribing to Media Channels

In the Routing View, a blue square at the intersection of an Rx and a Tx channel indicates that is it
possible to create a media route between those channels. A grey square indicates that it is not possible
to create a route between those channels. This may be because of a mismatch in sample rate between
the transmitter and receiver, or because a device cannot route to itself.

When you click a blue square at the cross-point between a transmit channel and a receive channel, a
subscription will be created, and a green tick ! will appear in the matrix cross point. You may initially

see a grey hourglass icon = (usually very briefly) to indicate that the subscription is in progress.

If there is a problem with the subscription, either a warning 2 or an error icon ﬁl" may appear. If many

devices have been subscribed at the same time, a yellow pending " icon may appear temporarily.
Hover the mouse over subscription icons to see a related tooltip (see Subscription Tooltips).

0 Note: Subscriptions can also be created in the Device View. This is covered in the Device View
section.

0 Note: You cannot create new subscriptions to a locked device; however, existing subscriptions
can be removed and replaced.

Subscribing to Multiple Media Channels at once

To subscribe multiple channels at the same time, hold down the Ctrl key and click the [-] symbol at the
top left corner of the intersection between the two devices. All possible channels will be subscribed at
the same time (see the figure in Expanding the Routing View).

Unsubscribing Media Channels

To unsubscribe a media channel, click on the cross-point containing a subscription. The subscription
icon will be removed and revert to a plain blue square.

Subscription Status

The symbol displayed at the intersection of the Tx channel and the Rx channel in the Routing View
provides information on the status of the subscription or connection, as follows:

E In progress  The subscription is in progress

4 Subscribed  Connection is established and fully functional

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -20-
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'y Warning This may indicate that:

= The subscription is unresolved, possibly because the transmitting device is
not visible on the network (for example, because it has been removed, or
switched off); or:

= There is another connectivity issue in the physical network that is affecting
a media signal

h!_. Error An error has occurred - for example, there is insufficient bandwidth to establish
the subscription

I Pending Device is part-way through setting up subscription. Most commonly seen when
subscribing many channels at a time

0 Note: The status of a subscription can change after it has been initially established, due to
changes in the network or changes in other devices.

Subscription Tooltips
Hovering the mouse over a subscription icon in the Routing tab displays a tooltip containing information
about the subscription.

If there is no problem with the subscription, the tooltip will display the Rx channel and device name, plus
the Tx channel and device name (for example, 'kick@Monitor-Console <- 01@Stagebox-2"), plus the
subscription status, and for successful subscriptions, the subscription type (unicast / multicast).

]

kick@Meonitor-Conscle <- 01 @5tagebox-2

Subscription status i1t Connected {unicast)
E_I
i

Other messages are displayed if the subscription is in any other state.
Some common messages are:
® 'Incorrect channel format: source and destination channels do not match'
The receiver and transmitter are set to different sample rates.
= 'Mismatched clock domains: The transmitter and receiver are not part of the same clock domain'

One of the devices is configured with sample rate pull-up/down that does not match the other
device.

® 'Tx Scheduler failure'

This is typically because you are trying to use sub-millisecond latency over a 100 Mbps network
link (1 msec is the minimum supported latency over 100 Mbps links).

= 'No Receive flows: receiver cannot support any more flows'

Indicates the receiver is subscribed to too many devices (devices typically do not support the
same number of flows as they do channels). See Routing Audio > Flows for more information.
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® 'No more flows (TX): transmitter cannot support any more flows'

Indicates that too many devices are subscribed via unicast to the transmitter. See Fanout for more
information.

® 'Cannot change: Locked receiver.'

Indicates a subscription from a locked receiver. Subscriptions from locked receivers cannot be
changed.

®= 'Warning: Locked transmitter.'

Indicates that the transmitter is locked. You cannot create new subscriptions to a locked
transmitter.

= 'Access control failure: Transmitter is locked.'
Indicates a subscription that failed because the transmitter is locked.

Differentiating Between Input and Output Channels

Channels are classified according to whether they put data onto, or take data off the network:
= A channel that puts data onto the network is known as a transmitting, Tx or output channel.

= A channel that takes data off the network is known as a receiving, Rx or input channel.

Device and Channel Names

In Dante, devices and media channels are identified by names, not 'magic numbers'. Device and
channel names can be customized.

= Dante routing is performed using the Device and channel names. A receive channel can be sub-
scribed to the name of a transmit channel at a device.

Example: “Analog L@my-transmitter”describes achannel named “Analog
L” on adevice named “‘my-transmitter”. Device names must be unique on a
Dante network. Channel names must be unique on the device.

= |f a device or channel is renamed, Dante routing considers it to be a different device or channel. If
a new device or channel is then given the old name, Dante routing will route from the new device in
place of the previous device.

Example: The power supply on “stage-box” fails and “stage-box” needs to be
replaced. The old “stage-box” is removed, and a new box is plugged in and
named “stage-box”. Dante receivers previously subscribed to the old “stage-
box” will now automatically restore their subscriptions to the new “stage-box”.

= Device names must be unique on the network. If you attempt to rename a device using Dante Con-
troller to a name that is already in use on the network, Dante Controller will notify you and reject
the name change.

Example: There is an existing device on the network called “MY16-slotl”. If user
attempts to rename another device to “MY16-s1lot1” Dante Controller will notify
you that the name is already in use. The device will not be renamed.

= |fa new device is added to the network with a name that already exists, a name conflict is detec-
ted. One of the devices will adopt a temporary placeholder name, by appending a space and (2) to
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its old name. This device will not be able to transmit media until it is manually renamed, and some
configuration options will be disabled for that device in Dante Controller.

Note: A device that has been renamed with (2) appended (e.g. “MY16-slotl (2)”) will not be

able to transmit media until it is renamed. The device name must be changed by the user to be a
valid non-conflicting name before the device can become fully functional. A device that has failed
with a name conflict will retry its configured name if it is rebooted. If the other device has been
removed or renamed, the previously failed device will resume normal operation.

Rules for Names

All Dante names are up to 31 characters in length.
Name comparisons are case-insensitive: “Guitar” and “guitar” are treated as the same name.
Unicode and non-roman characters are not supported.

Device names should follow Domain Name System (DNS) hostname rules. Legal characters are
A-Z, a-z, 0-9, and '-' (dash or hyphen).

Device names cannot begin or end with a hyphen.
Device names must be unique on the network.
Tx channel names may use any character except '=' (equals), ".' (full stop or period), or '@’ (at).

Tx channel names must be unique on a device. Tx channel names do not need to be unique on the
network, as they are always qualified by device (channel@device).

Rx channel names follow the same rules as Tx channel names .

Routing Media

Routing Terminology

Device: A device means a Dante-enabled device, and more specifically that component of the
equipment that implements the Dante interface. A Dante device typically has Tx and Rx channels
and other routing-related properties.

Transmit (Tx) channel: A transmit channel transmits media from the media hardware onto the net-
work.

Receive (Rx) channel: A receive channel receives media from the network and sends it to the
media hardware.

Flow: Dante media routing creates flows. Each flow carries several channels of audio, or one chan-
nel of video from a transmitter to one or more receivers. Unicast routing creates flows to single
receivers. Multicast routing creates flows that can be received by multiple receivers. Multicast
flows are assigned IDs enabling them to be identified in Dante Controller.

Unicast routing: Unicast flows are point-to-point from a single transmitter to a single receiver.
Unicast flows typically have room for 4 channels of audio or 1 channel of video.

Multicast routing: Multicast flows are one-to-many from a single transmitter to any number of
receivers. Use Dante Controller to choose which channels are to be multicast. Unlike unicast rout-
ing, multicast flows consume network bandwidth even if there are no receivers, but do not require
additional bandwidth to add more receivers.
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= Subscription: A subscription configures a receive channel to receive media from a transmit chan-
nel on another Dante device.

= Subscription status: For a receive channel, subscription status indicates whether it is subscribed,
whether it is receiving unicast or multicast media, whether the subscription is OK, or whether an
error has occurred.

Subscription
Dante routing is performed by associating a receiving (Rx) channel with a transmitting (Tx) channel. This
is called 'subscription'.

Example: Route Tx channels 1 and 2 (hamed “Audio L” and “Audio R”) on the device named
“Source” to Rx channels 3 and 4 on the device named “Dest”.

Source Dest
1: “Audio L” 3: “Audio L@Source”

2: “Audio R” 4:“Audio R@Source”

Rx channels 3 and 4 on “Dest” are subscribed as follows:
® 3 Audio L@Source

B 4. Audio R@Source

Dante will perform the necessary routing to deliver the media from the Tx channels to the Rx channels.

Redundancy

Many Dante devices support redundant media routing. These devices have two network interfaces,
named primary and secondary. Primary interfaces should be connected to one physical network. If
redundancy is being used, secondary interfaces should be connected to a second separate network.
Secondary interfaces cannot communicate with primary interfaces.

Dante controller

Dest1
1: “Audio L@Source”

Network A
(primary)

Non-redundant Dante device
Source

1: “Audio L”

2:“Audio R”

Dest2
1: “Audio L@Source”

. 2: “Audio R@Source”
Redundant Dante device

Network B
(secondary)

Redundant Dante device
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If the secondary network is connected to a device that supports redundancy, it is enabled automatically.
The same media data is transmitted on both the primary and secondary networks simultaneously. In the
event of a failure on one network, media will continue to flow via the other network.

Note: Dante redundancy requires that both the primary and secondary interfaces on any
redundant device are connected using the same link speed. For example, if the primary interface is
connected to a 1 Gbps switch port, the secondary interface must also be connected to a 1 Gbps
switch port. Similarly, if the primary interface is connected to a 100 Mbps switch port, the secondary
interface must also be connected to a 100 Mbps switch port.

Note: Dante devices that do not support redundancy must be connected to the primary network
only.

Media Formats

Most Dante devices support a range of media formats (audio sample rates, or video resolutions).
Devices can usually be switched between media formats, but will not support more than one at a time.

It is only possible to set up a subscription between channels which have a common media format.
Channels on devices with incompatible formats will be shown in grey, and will not be routable.

Flows

Dante media routing creates 'flows'. Each flow carries one or more channels of audio, or one channel of
video from a transmitting device to one or more receiving devices. There are two types of flow, unicast
and multicast.

Unicast routing creates flows to a single receiving device; a unicast flow typically assigns space for 4
channels of audio, or 1 channel of video. Unicast flows are set up when a receiver subscribes to an
available media channel, and are automatically removed when the receiver unsubscribes from all
channels in that flow.

Multicast routing creates flows that can be received by multiple receivers. Multicast flows are assigned
IDs, enabling them to be identified in Dante Controller, and to facilitate their removal. In contrast to
unicast flows, multicast flows must be set up on the transmitting Dante device before receivers can
subscribe to these flows.

Advanced Routing: Using Multicast

Dante routing is unicast by default. This means that a separate flow is set up between each transmitter
and receiver. If several receivers are all subscribed to the same channels of a transmitter, it may
sometimes be more efficient to use multicast.

Multicast sends the same set of channels to multiple receivers. In practice, this usually means that the
flow is flooded throughout the network. If many receivers want the same channels, using multicast can
reduce overall network use, especially on the transmitter, because only one copy of each channel needs
to be sent, rather than many.

Dante receivers will automatically prefer multicast to unicast if it is available. This means that if a new
multicast flow is created containing the channels that a receiver is currently receiving as unicast, the
receiver will switch over to receiving media from the multicast flow and the unicast flow will be removed.
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Routing for Video Devices

Video (Dante AV) devices support three major channel types.

Audio Channels
Audio channels are represented in Dante Controller by the following icon:
0

Audio channels for Dante video devices are treated and managed identically to audio channels for
audio-only Dante devices.

Video Channels
Video channels are represented by the following icon:

i3]

Video channels contain packetised video data streams, and can be routed in the same way as audio
channels. However, they typically use more bandwidth than audio channels, and require 1Gbps (or
higher) switch ports.

Note: IGMP snooping must be enabled on network switches that will be carrying Dante video on
1Gbps network infrastructure. Refer to your switch manufacturer's documentation for information
about enabling IGMP snooping.

Ancillary Channels
Ancillary channels are represented by the following icon:
v

Ancillary channels are 'custom' channels, defined by the device manufacturer, to carry additional data
(not audio or video) between devices. Typically they are used to carry hardware control data, such as
USB peripheral or infrared transport control data.

Ancillary channels are typically low bandwidth (compared to audio and video channels).
Some ancillary channel types cannot be added to multicast transmit flows.

A typical Network view for a network that includes video devices (with four types of ancillary channels) is
shown below.

In this example:

® The 'Video Rx' channel on the AV-Display-FOH receiver is subscribed to the 'Video Tx' channel on
the AV-Mixer transmitter.

This subscription would cause video from the AV mixer to be displayed on the front of house
display screen.

® The'01'and '02' audio channels on the Amp-FOH1 audio receiver are subscribed to the 'Left' and
'Right' Tx channels on the AV-Mixer transmitter.

These subscriptions would cause the left and right audio channels from the AV mixer to be played
out via the front of house amplifier.

® The'USB'and'IR' ancillary channels on the AV-Display-FOH receiver are subscribed to the
equivalent channels on the AV-Mixer transmitter.

These subscriptions would enable USB peripheral (for example, mouse and keyboard) and
infrared control of the transmitter via the control ports on the receiver.
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Note that control data on some types of ancillary channel (somewhat counter-intuitively) may
actually flow from the receiver to the transmitter. This enables transmitting video sources to be
controlled remotely at the receiver. For example, you could start and stop a Blu-Ray player (a
transmitter) in another room using an infrared remote control pointed at the screen that is actually
playing the video (a receiver).
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Clock Synchronization

In Standard Dante Networks

All Dante-enabled devices use the IEEE 1588 Precision Time Protocol (PTP) across the network to
synchronize their local clocks to a leader clock, providing sample-accurate time alignment throughout
the network.

One Dante device will be elected as the PTP Leader Clock for the network; all other Dante devices act
as a PTP Follower Clocks to the elected leader clock. Although many Dante devices may be capable of
becoming PTP Leader Clock, only one device will win the election. Devices with clock inputs (e.g. Word
Clock or AES3) will be preferred in the election process. A gigabit connected device is preferred over a
device connected via 100Mbps. A tie-breaker rule of the lowest MAC address is used if several
equivalent candidate leader clocks are available. The election process may be overridden by manually
setting 'Preferred Leader' on a device.

Dante Clock Types

Each Dante hardware device can derive its clock from either its high-quality onboard clock circuit, or an
externally connected word clock. In the case of Dante Virtual Soundcard, the computer’s clock will be
used.

Clock Settings
Enable Sync To External

A Dante device set to 'Enable Sync To External' will use the external word clock from its host equipment
to tune its onboard VCXO. A Dante device with this attribute set will become the PTP Leader Clock,
unless there is another Dante device present with 'Preferred Leader' set.

Preferred Leader

Sometimes it may be necessary to force a particular device to provide the PTP Leader Clock. A Dante
device with 'Preferred Leader' set will always be chosen as the PTP Leader Clock. If more than one
device has 'Preferred Leader' set, the device with the lowest MAC address will be chosen.

@ Note: If device A is deriving its clock from an external word clock source ('Enable Sync To
External'), but device B is set as Preferred Leader, device A will lose sync with the Dante network
and will eventually be muted - unless device B is also deriving its clock from the same external
source as device A.

m Clock Status

Clocking and Synchronization in Redundant Networks

In a redundant network, the clock synchronization protocol operates over both primary and secondary
networks. Each network will have a designated PTP leader clock; usually this will be the same device on
both networks. If this is not the case (e.g. if a non-redundant device is designated Preferred Leader)
then one device will bridge the clock synchronization information from the primary to the secondary
network, ensuring that all devices derive their clock from the same source. Redundant PTP Follower
clocks will synchronize their local clocks based on information from one of the networks they are
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connected to. In event of a failure on one network, a redundant device will continue to receive clock
synchronization information over the other network.

In Dante Domains

In Dante domains, there is one Primary Leader clock, and if the domain spans IP subnets, an additional
'subnet leader' clock for each subnet, plus one or more boundary clocks for each subnet. The subnet
leader may also be a boundary clock for its own subnet.

Boundary clocks use PTP v2 (IEEE 1588-2008) for unicast clocking between subnets. Boundary clocks
can be manually or automatically specified using the DDM web interface.

Each Dante domain will use its own individual clock domain, unless media sharing between domains is
configured, in which case all domains in the shared media group share the same clock domain.

Latency

For Audio Devices

For Dante audio devices, variation in latency in the network is compensated for at the receiver. Each
receiver has a device latency setting. This setting defines the latency between the timestamps on the
incoming audio samples and when those samples are played out.

The typical default latency for a Dante audio device is 1 msec. This is sufficient for a very large network,
consisting of a Gigabit network core (with up to 10 hops between edge switches) and 100 megabit links
to Dante devices. Smaller, Gigabit-only networks can use lower values of latency (down to 150 psec for
very fast devices, such as PCle cards). Recommended latency settings are displayed in Dante
Controller, and may also be found in the documentation accompanying the product.

Latency is set on the receiver. However, when a subscription is made, there is an automatic negotiation
process between the receiver and the transmitter, to ensure that the latency for the subscription is high
enough to prevent packet loss.

For example, Ultimo devices support a minimum of 1ms latency. If a faster device (such as a PCle card)
is set to 0.25ms latency, and is then subscribed to an Ultimo transmitter, the latency used for the
subscription will be 1ms, which is the minimum supported latency for the subscription. Subscriptions to
other devices (such as a Brooklyn Il device) will be set at Tms (or whatever latency the receiver is set to).
This effectively makes the device latency setting a 'default’ latency, which is used unless the transmitter
doesn't support it.

Note: The minimum latency available for a device connected to a 100 Mbps network port is 1
msec.

Using a latency lower than 1 msec over a 100 Mbps link will result in a subscription error, with the
tooltip "Tx Scheduler Failure'.

Latency Monitoring

Dante Controller provides latency monitoring for supported devices. For more information, see Latency
Tab.
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Latency and Dante Virtual Soundcard

Dante Virtual Soundcard allows a standard Apple Mac or Windows PC to function as a Dante device.
Because Dante Virtual Soundcard runs on a general purpose computer without special hardware to
support Dante timing requirements, additional latency needs to be added to connections received from a
Dante Virtual Soundcard transmitter.

Dante Virtual Soundcard is configured with custom latency values for reliable operation. Dante devices
with Rx channels that are subscribed to Tx channels from a Dante Virtual Soundcard transmitter will
automatically configure themselves to use these higher latency values for those channels only. The
latency on all other subscriptions on the receiver is unaffected.

Latency in DDM Networks

Devices that are enrolled in a Dante domain may support extra latency values, to accommodate larger
network topologies.

If a device is un-enrolled while it is set to one of these latency values, its latency will be automatically
reset to the default value for the device.

For Video Devices

For video (Dante AV) devices, the Device Latency setting in Dante Controller applies to the audio
channels only.

Device Lock

Device Lock allows you to lock and unlock supported Dante devices using a 4-digit PIN (Personal
Identification Number).

When a device is locked, media will continue to flow according to its existing subscriptions, and it can be
monitored, but it cannot be controlled or configured - its subscriptions and configuration settings become
read-only.

To configure a locked device you must first unlock it using the PIN with which it was locked.

Locked devices can be identified by:

- A small gray padlock icon against the device name in the Network View > Routing tab
= A red background highlight when the device is moused over in the Network View > Routing tab
= A check (tick) in the Device Lock column in the Network View > Device Info tab

™
A red padlock icon in the Device View toolbar a

Not all Dante devices support Device Lock.
To check if a Dante device can be locked:
®  Use the Advanced Filter to check for locked, unlocked and unsupported devices

= Check the Device Info tab - devices that support Device Lock have a checkbox in the Device Lock
column; devices that do not support Device Lock show ‘N/A’ in the Device Lock column

= Open the device in Device View - if the padlock icon in the toolbar is blue or red, the device sup-
ports device lock; if it is grayed out, it does not support Device Lock

= [f in doubt, contact the device manufacturer
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Locking a Dante device

To lock an unlocked Dante device:

Using Device View

L
1. Open the device in Device View (Ctrl + D, or Command + D) and click the padlock icon LT

The Lock Device panel is displayed.

In the Lock Device panel, enter a 4-digit PIN in the PIN field.
3. Enterthe same PIN in the Confirm PIN field.
4. Click ‘Lock’.

i~
The padlock icon will change to red Ly indicating that the device is now locked.

From the Device Info Tab
1. In Network View, select the Device Info tab.

2. Click the Device Lock checkbox for the device.

3. Follow steps 2-4 from the above process.

Unlocking a Dante Device

To unlock a locked Dante device:
Using Device View
[
1. Open the device in Device View (Ctrl + D, or Command + D) and click the padlock icon 2

2. Inthe Unlock Device panel, enter the 4-digit PIN in the PIN field.
3. Click Unlock.

i
The padlock icon will change to blue s indicating that the device is now unlocked.

From the Device Info Tab
1. In Network View, select the Device Info tab.
2. Click the Device Lock checkbox for the device.

3. Follow steps 2-3 from the above process.

Unlocking a Device When You Have Forgotten the PIN

If you have forgotten the PIN for a locked device, you can reset the PIN.
To reset the PIN for a locked device:
1. Isolate the device from the rest of the Dante network.

2. Disconnect and reconnect the device.
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3. Wait for at least 2 minutes.

4. Use the ‘Forgot PIN’ option in the Unlock Device panel.

How to Isolate a Device from the Rest of the Dante Network
There are 3 ways to isolate a device from the rest of the network.

Option 1: Remove all other Dante devices from the Dante network

You can isolate a device by physically disconnecting all other Dante devices from the network switch, or
by completely powering down all other devices, leaving on the network only the locked device and the
computer running Dante Controller.

0 Note: Dante Virtual Soundcard and Dante Via are considered to be Dante devices - all running
instances of those applications must be fully stopped, even if they are on the same computer on
which you are running Dante Controller.

Option 2: Connect your Dante Controller computer directly to the device

Physically remove the device from the main Dante network switch, and either connect it directly to your
Dante Controller computer (using a normal Ethernet cable), or connect the device and your computer to
a separate network switch (to which there are no other Dante devices connected).

Option 3: Use a VLAN

Set up a Virtual Local Area Network on which there are only the locked device, and the Dante
Controller computer.

Resetting the PIN for a Locked, Isolated Device

Once you have isolated the locked device, disconnected and reconnected it, and then waited for at least
2 minutes:

1. Open the Unlock Device panel for the device (See Unlocking a Dante Device).
2. Click the ‘Forgot PIN’ option.
3. Click Reset.

The device is now unlocked, and can be re-locked using a new PIN if required.

Subscriptions from Unlocked Devices to Locked Devices

If there are existing subscriptions to a device when it is locked, those subscriptions will continue to
function as normal.

They can also be removed, and replaced (assuming the subscribing device is unlocked).

No new subscriptions can be made to a locked transmitter. The 'Access control' tooltips are associated
with attempted subscriptions to locked transmitters.

0 Note: If you attempt to subscribe a legacy (pre-v3.10 firmware) receiver to a locked transmitter,
subscription status icons for any existing subscriptions (made before the device was locked) may
change to indicate an error state. However, audio will continue to flow for those subscriptions. To
reset the subscription icons: Remove all subscriptions, and reinstate the original subscriptions
only.
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Locking Devices with Residual Connections

Occasionally, a transmitter will have residual unused connections (transmitting but unsubscribed
channels) from a previous subscription state, which need to be closed before the device is locked. This
can cause an interruption to media from that device.

When you attempt to lock a device and residual connections are detected, Dante Controller presents a
warning dialog:

@ Warning >

The device FOH-Desk has residual unused connections which will be dosed before locking.
This may cause a brief interruption to audio from this device to the following devices:
Amp-FOH
PCIe-Record
Amp-Lobby

Cancel

Click Ok to proceed or Cancel to abort the lock process.
While the residual connections are being closed, Dante Controller displays a progress dialog:

& Preparing Device pd
_

When the preparation process is finished, the standard Lock Device dialog is presented, and the device
can be locked as normal.

Dante Control and Monitoring

In addition to automatic configuration and discovery, media transport and routing, Dante-enabled
devices can also be controlled and monitored in various ways. This includes being able to view and
change specific parameters, such as clock configuration settings. Dante devices are also capable of
sending status events that can be viewed using Dante Controller. Status events include changes in
clock status, or network interface changes.

0 Note: The computer service that manages control and monitoring is called 'ConMon' or 'Dante
Control and Monitoring'.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -33-



Dante Controller User Guide /ﬁi Ud i nate®

Starting Dante Controller

Where to find the Dante Controller application

Windows

By default Dante Controller will be installed in
C:\Program Files (x86)\Audinate\Dante Controller\
It can be started in several ways:
= Using the Start menu: Start > Audinate > Dante Controller > Dante Controller

= Run by going to Start > Run and entering
C:\Program Files\Audinate\Dante Controller\DanteController.exe
in the dialog box

"4

u
Navigate to the directory where it is installed, and double-click the Dante Controller icon; .=

macOS

The Dante Controller application will be installed in the Applications folder.
To start:

u
Navigate to Applications folder, and double-click the Dante Controller icon: @

Or:
® Drag the icon to the Dock and click on it

Configuring Dante Controller

Network Interface Selection

Dante Controller can communicate with other Dante devices on the primary network, or the secondary
network, or both. Dante Controller needs to know which of the network interfaces of the host computer is
connected to each physical Dante network.

Dante Controller supports connection to Dante networks via Ethernet and Wi-Fi network interfaces.

The first time Dante Controller is run, you may be presented with the Configure Dante Interfaces dialog
(shown below). Use this dialog to select the primary and secondary Dante interfaces. Once interfaces
have been selected, they are remembered for future use, and this dialog will not be shown when Dante
Controller is run subsequently.
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& Configure Dante Interfaces in Unmanaged mode >

Select the network interface that the Dante Controller
will use to communicate with other Dante devices (in unmanaged mode):

"""" Ethernet 1 ~
Primary Interface: 1G IP: 10.13.10.201
Ll MAC: 74:D4:35:19:F5:AF

"""" Ethernet 2 ~
IF: 1%2.168.30.1%8
L) MAC: 20:1F:02:D6:3F:3F

Secondary Interface:

Ok

0 Note: In DDM networks, Dante Controller may use a different interface to connect with Dante
devices.

0 Note: When connecting a network interface on your computer to a secondary Dante network with
no DHCP server, the network interface should be configured with a static IP address in the
172.31.*.* range, with a subnet mask of 255.255.0.0.

The icons displayed indicate the selected interface type and status:

Operational 1Gbps Ethernet interface

Operational 100Mbps Ethernet interface

I 1111000 I
Disabled / disconnected Ethernet interface, or no interface selected

D) ]

Operational Wi-Fi interface

H Wi-Fi interface selected with no Wi-Fi network connection
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i
To display this dialog at any other time, click the ®®®| putton in the main toolbar.

Use Shared Dante Interface

With this option selected, the selected primary network interface will be automatically used by other
Audinate software applications installed on that computer (including Dante Via, Dante Virtual Soundcard
and Dante Updater) when they are started. This helps to ensure that all Audinate applications are
connected to the same Dante network.

Only wired Ethernet network interfaces are supported in this mode.

With ‘Use shared Dante interface’ deselected, Dante Controller is able to connect to any available
Ethernet or Wi-Fi network interface, and the selection is fully independent of any other Audinate
software applications.

Wi-Fi Network Connections

To connect to a Dante network via Wi-Fi, a Wi-Fi access point must be present and enabled on the
Dante network - for example, a Wi-Fi router physically connected to a network switch or Dante device in
the Dante network.

0 Note: Dante audio and video transmission over Wi-Fi is not supported.

To connect to a Dante network using Wi-Fi:
1. Ensure your Wi-Fi interface is successfully connected to a Wi-Fi network.
2. Ensure ‘Use shared Dante interface’ is deselected.

3. Select your Wi-Fi network interface in the Configure Dante Interfaces dialog.

m See also: Using Wi-Fi and Multicast Transmit Flows

Network Interface Configuration Guidelines

Primary only (non-redundant) Dante network
If you only have a primary network, you can only connect one interface to the Dante network.

Example
In the example below, the laptop (running Dante Controller) and the two Dante devices are connected to
the switch via their primary interfaces. This is a typical non-redundant Dante network.

If the laptop has two network interfaces, either can be used.
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Primary and secondary Dante networks (redundant configuration), only one
network interface on the host computer

If you have primary and secondary (redundant) networks, but only one network interface on your
computer, you should set your computer's network interface as the primary interface. This ensures that
you can control any non-redundant devices, and see full connection information for any redundant
devices that are connected to non-redundant devices.

If a problem does occur, and you lose connectivity on the primary network, you can connect instead to
the secondary network, to maintain control over your devices. This entails changing the physical
connection (i.e. physically connecting your computer to a switch on the secondary network), and
changing the interface selection in the Configure Dante Interfaces dialog.

Example
In the example below, the laptop (running Dante Controller) is connected to the switch via one interface
only, which is set as the primary Dante interface.

The two Dante devices are connected to the primary switch via their primary interfaces, and to the
secondary switch via their secondary interfaces. The two switches are not connected to each other. This
is a typical redundant network configuration for computers with only one network interface.
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0 Note: When connected to the secondary network, you will not have control over devices that are
only connected to the primary network (i.e. non-redundant devices, or Dante Virtual Soundcard).
You will see the device names in the Network view, and in subscription dialogs (for example, the
Device View > Receive and Transmit tabs) but you will not be able to view or edit device
configuration for those devices. Also, if the leader clock is only connected to the primary network,
its name will not resolve in the 'Leader Clocks' section of the main window tool bar, it will be shown
as a MAC address string.

Primary and secondary networks (redundant configuration), two network interfaces
on the host computer

If you have primary and secondary networks, and two network interfaces available on the host
computer, you should connect one interface to each network. This means that you will always have full
control of all redundant devices, even if the primary network fails.

Example
In the example below, the laptop (running Dante Controller) and the two Dante devices are connected to
the primary switch via their primary interfaces, and to the secondary switch via their secondary
interfaces. The two switches are not connected to each other. This is a typical redundant network
configuration for computers with two (or more) network interfaces.
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0 Note: All Dante applications on the same computer have a shared understanding of which
interface is the primary Dante interface. For example, if you have installed Dante Virtual Soundcard
on the same computer as Dante Controller, and a new primary interface is selected from within
Dante Virtual Soundcard, Dante Controller will automatically switch to the newly selected interface,
and begin operating on that interface.

Connection via Wi-Fi

To connect to a Dante network via Wi-Fi, a Wi-Fi access point must be physically connected to the
Dante network (either to a network switch, or to a Dante hardware device). The Wi-Fi interface on the
Dante Controller computer must be connected to the Wi-Fi access point.

Example
In the example below, the computer running Dante Controller is connected via W-Fi to a Wi-Fi access
point connected to the primary Dante network.
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Using Wi-Fi and Multicast Transmit Flows

When using a Wi-Fi network connection between Dante Controller and your Dante network, any
multicast transmit flows configured in your network routing can flood the Wi-Fi link, and degrade the
performance of the link.

You may be experiencing this condition if;
1. You are using a Wi-Fi network connection
2. You have multicast transmit flows in place

3. You observe speed or stability issues with your Wi-Fi connection

Remedial action
Remove or reduce the multicast traffic

The easiest way to remedy this condition is to either remove all multicast flows and use unicast flows
instead; or, reduce the amount of multicast bandwidth on the network by removing some multicast flows.
There is no hard rule that specifies how much multicast traffic is too much for a Wi-Fi link - the
performance of the link is the best real-world indicator.

If you are unable to remove or reduce multicast traffic, there are various ways to filter multicast media
traffic from the Wi-Fi link.

Filter multicast media at the access point

Depending on the type of Wi-Fi access point (or AP - typically, a W-Fi modem / router) that you have, it
may automatically block ‘unregistered’ multicast traffic, which is multicast traffic that hasn’t been
specifically requested by a network device. Because Dante Controller will never request to join a
multicast media stream, the AP will never send multicast media traffic (audio or video) to the Dante
Controller computer.
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It should however allow multicast control traffic - this is important for Dante Controller, because device
discovery in Dante uses a multicast control protocol.

If the AP doesn’t automatically block unregistered multicast, you may be able to proactively filter it out
using a ffilter multicast’ feature in the AP. The feature should filter the high-bandwidth multicast media
traffic, but again should allow multicast control traffic. Not all APs feature automatic multicast filtering, or
a ffilter multicast’ configuration option. Refer to the user manual for your AP for more information.

Connect the AP to a dedicated control port on a Dante device

Some Dante hardware devices include a ‘control port’, which is a Dante Ethernet port that automatically
filters multicast media traffic. Control ports should be clearly marked as such on the device.

You can connect your AP to this port, which will enable Wi-Fi connectivity between Dante Controller and
the network, but the port will not pass multicast media traffic to the AP. Refer to the user manual for your
device for more information.

Enable IGMP snooping on the network switch

Enabling IGMP snooping on the network switch will block multicast media to all switch ports unless a
device on that port has specifically requested to join a multicast group (stream). This means that
multicast media can flow between audio and video devices but will not flow over the AP to Dante
Controller. Refer to the user manual for your switch for more information.
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Using Dante Controller

Dante Controller presents two main types of view: Network View and Device View.

Q Important: After making changes to Dante network routing (e.g. subscriptions, device names,
channel names etc.) please wait at least 5 seconds before disconnecting or powering down any
affected devices. This ensures that the new information has been properly saved to the devices.
Device configuration (e.g. sample rates, latency, clock settings) are saved instantly.

0 Note: macOS users: Please note that the key combinations shown below are for Windows users.
When using Dante Controller on a Mac, use the “Command (CMD)” or “Apple” key instead of the
“Control” key when following the instructions below, and substitute standard Mac key combinations
where applicable - see the Dante Controller menu for details.

Network View

When Dante Controller is started, it opens at the Network View, with the Routing tab selected.
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0 Note: For networks that include video (Dante AV) devices, see Routing for Video Devices

Menu bar

The menu bar in the Network View includes four menus: File, Device, View and Help.

File

® | oad Preset (Ctrl+L): loads a configuration from a file

®m Save Preset (Ctrl+S): saves configuration for currently displayed devices to a file

= |nterfaces: Opens the Configure Dante Interfaces dialog
= Exit (Alt+F4): Exits Dante Controller

See Presets for more information.

Devices

= Refresh (F5): Refreshes the displayed network / device data

= Clock Monitoring: Toggles clock monitoring on/off
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® Connect Devices to Domain Manager
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= Device View (Ctrl+D): Opens a new Device View window

View
= Dante Updater (Ctrl + U)
= Dante Activator (Ctrl + 1)

® Domain Manager Login (Ctrl + O)
= Show Filter Pane (Ctrl + Shift + F)

= Show/Hide Channel Groups (Ctrl + Shift + G)

= Show Hidden Devices (Ctrl + E)

Help

= About: Shows the Dante Controller version, and current event log file location

= Show License: Displays the license text

®  Check for updates: Checks the update server for new Dante Controller versions

= Analytics: Disable / enable analytics data collection

= Online Help (F1): Opens this HTML user guide on the Audinate web server (requires an Internet

connection)

= Offline Help: Opens a locally-stored PDF of this user guide (may not be the latest version of the

user guide)

Tool bar

Below the menu bar there is a tool bar, containing these buttons:

u_] Filter pane

Reload Device Information

4

Load Preset

Save Preset

* N

Choose a Dante Interface

5

Clock Monitoring

I
i

E

Shows / hides the advanced filter pane.

Updates the current view with the latest device information
from the network. This is useful when a recent change to the
network has not yet propagated automatically through to
Dante Controller (for example, a new device has been
added to the network).

Loads a previously saved media routing configuration. See
Presets for more information.

Saves the current media routing configuration. See Presets
for more information.

Opens the Configure Dante Interfaces dialog. See
Configuring Dante Controller for more information.

Activates the Clock Status Monitoring function. See Clock
Status Monitoring for more information.
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+ Channel Groups Activates channel groups. See Channel Groups for more
|—| information.
@ Dante Updater Launches Dante Updater.
@ Dante Activator Launches Dante Activator.
Domain Manager Login Enables connection to a Dante Domain Manager server.

o)

To the right of the toolbar, Dante Controller displays the current Primary Leader clock (or clocks, in the
case of redundant networks or DDM networks).

To the right of the clock display is the currently-selected domain, and the currently logged in DDM user
(when logged into Dante Domain Manager).

Tabs

Click the tabs below the tool bar to view:
= Routing
= Device Info
= Clock Status
= Network Status

® Events

The use of each of these tabs is described in the next section.

Status Bar

The Status Bar displays notifications for network status, general device events, and clock status events,
plus the current Dante media multicast bandwidth on the network.

DDM Networks

In DDM networks, the devices displayed in the Network View will vary according to the selected domain.
See Viewing Domains in Dante Controller for more information.

When logged into a domain that includes legacy (pre-v4.0 firmware) devices, those devices are
displayed with gray highlighting instead of blue.

Shared devices are displayed with green highlighting and green text. See the DDM user guide for more
information about sharing audio in DDM networks.
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Status Bar

Stagebox-1
+ Stagebox-2 L [ EEE i B
1

P [l s [ 12devices  Audio Multicast Bandwidth: 14Mbps Eventlog: [ | Clock Status Monitor: [

The Status Bar displays the following information:

= P: The current status of the Primary network. Green indicates that Dante Controller is currently
connected to the primary Dante network. Red indicates a problem with the connection.

= S: The current status of the Secondary Dante network. Only displayed where a secondary network
is connected.

= The number of discovered devices on the network

= Audio Multicast Bandwidth: The current Dante audio multicast bandwidth on the connected net-
works for unmanaged (un-enrolled) devices. Note that there may be network traffic from other
sources that is not included in the multicast bandwidth reading.

= Event Log: Indicates the current status of the event log. Click the icon to open the Events View.

= Clock Status Monitor: Indicates the current status of the Clock Status Monitor. Click the icon to
open the Clock Status Monitor.

Network View Tabs

Routing View

When Dante Controller is started, it always displays the Routing Tab within the Network View. In this
view the network is shown in the form of a grid. Devices with Tx channels are displayed along the top
row of the grid, and those with Rx channels are displayed along the left-hand column of the grid. Initially
a collapsed view is presented; individual channels cannot be seen.

0 Note: If a device name is shown in red, it means Dante Controller has automatically detected an
error condition. Double-click the device name to see more information. Refer to Automatic
Notification of Device Errors for further explanation.

0 Note: If a device has Tx and Rx channels, it is shown both along the top row of the grid and also
along the left-hand edge.
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Expanding the Routing View
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The Rx channels associated with any device can be displayed by clicking on the [+] to the left of the
device name in the left-hand column of the grid. The Tx channels associated with any device can be
displayed by clicking on the [+] above the device name on the top row of the grid. When this action is
performed the grid view expands to show each channel of the device, and the [+] becomes a [-]. Clicking
on [-] collapses the view. You can also group channels into sets of 16.

The Rx channels associated with all devices can be simultaneously expanded by clicking on the [+] of
“[+1[-] Dante Receivers” at the top of the left-hand column. Similarly, the Tx channels associated with all
devices can be simultaneously expanded by clicking on the [+] of “[+] [-] Dante Transmitters” at the left of
the top row. Clicking on [-] will collapse the view.

Device List Filtering

The device lists in the Routing view can be filtered using the 'Filter Transmitters' and 'Filter Receivers'
boxes, below the Dante logo in the top left-hand corner. Any text string typed into the box will filter the
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view to only display devices that contain that text string, in either a device name, or channel name.

@abDante
Filter Transmitters

Filter Receivers

Dante Transmitters

The filtering is case-insensitive. For example, in the Dante Controller Network view shown here,
entering the string “foh” in either of the Filter fields would display only the FOH-Amp and FOH-Console
devices, and their channels.

m See also: Advanced Filter

Advanced Filter

About the Advanced Filter

The Advanced Filter can be used to filter the devices displayed in the Network View Routing, Device
Info, Clock Status and Network Status tabs.

Use the Advanced Filter to easily locate or display devices with specific names, channel names, states
or configuration parameters.

To open the advanced filter, click the sidebar button: I'J—]

Filter groups (including the text filter) are additive (AND logic, not OR logic). The devices displayed are
those that match all specified conditions. For example, entering ‘amp’ in the text filter and selecting ‘48k’
in the Sample Rate filter will display all devices with the ‘amp’ string in the device name (or receive
channel names) which are also set to 48kHz sample rate.

Inside a filter group, selections use OR logic. For example, selecting '44.1k’ and ‘48K’ in the Sample
Rate filter will display all devices set to either of those sample rates.

Text Filter

The text filter displays devices with device names or receive channel names that match the text string
entered into the Search field.

The device name filter is case-insensitive (capitalization is ignored), and allows alphanumeric
characters (a-z, 0-9) and the hyphen character (-). Wildcards are not supported.

To clear the device name filter, just delete the text in the Search field, or click the Clear All button.
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Device State and Configuration Filters

The device state and configuration filters can be expanded and collapsed using the plus [+] and minus
[-]icons.

Deuice Lock
[ ] Locked

[ ] Unlocked
[ ] Unsupported

Sample Rate
Media Type

Sync to External
Latency
Subscriptions

Tx Multicast Flows
AESGT

Sample Rate Pull-up

To filter devices for a particular condition or set of conditions, just select the required checkbox or
combination of checkboxes.

Use the Clear All button to clear the selections from all filters.
Device Lock Filter
Use the Device Lock filter to display devices with a specific lock state.
= To display only locked devices, select the 'Locked' checkbox.
= To display only unlocked devices, select the 'Unlocked' checkbox.
= To display locked and unlocked devices, select both the 'Locked' and 'Unlocked' checkboxes.

= To display devices that do not support Device Lock, select the 'Unsupported' checkbox.

Sample Rate Filter
Use the Sample Rate filter to display devices with a specific sample rate setting.
= To display only devices with a particular sample rate, select the appropriate checkbox.

= Todisplay only devices with one of a selection of sample rates, click the appropriate checkboxes.

Media Type Filter
Use the Media Type filter to display devices with specific channel types.
= To display only devices with video channels, select the 'Has Video Channels' checkbox.

= Todisplay only devices with audio channels, select the 'Has Audio Channels' checkbox.
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= To display only devices with ancillary channels, select the 'Has Ancillary Channels' checkbox.

= To display devices with a mix of channel types, select the appropriate checkboxes.

Video Subtype
Use the Video Subtype filter to display devices with the selected video format(s).
Ancillary Type
Use the Ancillary Type filter to display devices with specific ancillary channel types.
= To display only devices with USB channels, select the 'USB' checkbox.
= Todisplay only devices with serial channels, select the 'Serial’ checkbox.
= To display only devices with IR channels, select the 'IR' checkbox.

= To display devices with a mix of channel types, select the appropriate checkboxes.

Sync to External

Use the Sync to External filter to display devices with a specific Sync to External setting.
= To display only devices with Sync to External enabled, select the 'Enabled’ checkbox.
= To display only devices with Sync to External disabled, select the 'Disabled' checkbox.
= To display devices with either setting, select the 'Enabled' and 'Disabled’' checkboxes.

= To display devices that do not support Sync to External, select the 'Unsupported' checkbox.

Latency
Use the Latency filter to display devices with a specific latency setting.
= To display only devices with a particular latency, select the appropriate checkbox.

= Todisplay only devices with one of a selection of latencies, click the appropriate checkboxes.

Subscriptions
Use the Subscriptions filter to display devices with a specific subscription state.
= To display only devices with no subscriptions, click the 'None' checkbox.

= To display only devices with one or more successful subscriptions, click the 'Has Successes'
checkbox.

= To display only devices with subscription warnings, click the 'Has Warnings' checkbox.
= To display only devices with subscription errors, click the 'Has Errors' checkbox.
Note: ‘Success’ will not only display devices with only successful subscriptions - it will also display

devices with a mix of successful and failed subscriptions. Similarly, ‘Failure’ will also display devices
with a mix of failed and successful subscriptions.

Tx Multicast Flows
Use the Tx Multicast Flows filter to display only devices with Tx Multicast Flows configured.

= To display only devices with one or more Tx Multicast Flows configured, select the 'Active' check-
box.

AES67

Use the AES67 filter to display devices with a specific AES67 setting.
= To display devices with AES67 enabled, select the 'Enabled' checkbox.
= To display devices with AES67 disabled, select the 'Disabled' checkbox.
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= To display devices with either setting, select the Enabled and Disabled checkboxes.

= To display devices that do not support AES67, select the 'Unsupported' checkbox.

Sample Rate Pull-up
Use the Sample Rate filter to display devices with a specific sample rate pull-up setting.
= To display only devices with a particular pull-up, select the appropriate checkbox.

= To display only devices with one of a selection of pull-ups, click the appropriate checkboxes.

Channel Groups

When Channel Groups is active, device channels in the Network View Routing tab are grouped into
sets.

This makes it easier to view and make channel subscriptions for devices with large numbers of
channels, such as PCle cards.

]

By default, the groups are named 1..16, 17..32 etc. - however, some devices may use custom grouping
configurations.

To activate it, click the Channel Groups button in the Network view toolbar:

+| —| Dante Receivers

=+ DSP-Processor

+ DS

+ FOH-Amp

- onsole

—1..16
fdvox 1
Edvox 2
& ¥ guitar 1
& ¥ guitar 2
& d bass
fdkeys 1
Ed keys 2
£ MC
€3 kick
¥ snare 1
& ¥ snare 2
i3 hats
¥ ride
i OHL
(3 OHR
¥ perc
+17..32

+ Lobby-Amp

1
slsls

Seeffffocccefoooe

S

To expand a channel group, click the plus [+] icon. To collapse a channel group, click the minus [-] icon.
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Note: Grouping channels does not affect routing or device behaviour.

Device Info

Routing Device Info | Clock Status  Network Status  Events

Product Dante Device

Device Model Primary Primary dary dary
Hame Name Version Version Lock Address Link Speed Address Link Speed
Amp-FOH Mexus-6 1.0.0 4.0.8.17 I:‘ 10.10.60.52 100Mbps r r
Amp-room2 Mexus-6 1.0.0 4.0.8.17 |:| 10.10.50.41 100Mbps

Desk-monitors T-850 2.0.0 4.0.7.8 I:‘ 10.10.60.62 1Gbps

Desk-room2 T-850 2.0.0 4.0.7.8 D 10.10.60.57 1Gbps

Eliot-PC2 Dante Virtual Soundcard 4.0.2.1 O 10.10.60.66 1Gbps

Paging Mexus-8 234 4.0.8.17 |:| 10.10,60.138 100Mbps A
PCle-Rec NETWORK IjO PCle-R 1.0.0 3.10.2.1 I:‘ 10.10.60.60 1Gbps Link down
Stagebox-1 T-800 2.0.0 4.0.7.8 I:‘ 10.10.60.129 1Gbps r

The Device Info tab provides a network-wide overview of device configuration and operating
information. For DDM networks, devices are grouped into their respective IP subnets.

The tabular view presents the following information, in columns from the left:
= Device Name: The device name currently associated with the device
= Model Name: The model name of the device
= Product Version: The product version assigned by the manufacturer

® Dante Version: The firmware version for hardware devices, or software version for Dante software
applications

= Device Lock: The lock state of the device. You can also click this field to open the device lock /
unlock dialog.
= Product Version: The product version, as defined by the manufacturer

= Primary Address: The IP address assigned to the primary interface.
IP addresses are currently assigned via DHCP, or automatically self-assigned. Self-assigned
addresses on the primary interface will be in the 169.254.*.* range.

= Primary Link Speed: The Ethernet link speed of the primary interface

= Secondary Address: The IP address assigned to the secondary interface.
Self-assigned addresses on the secondary interface will be in the 172.31.*.* range. 'N/A' indicates
that the device does not support a secondary interface. 'Link down' indicates that the device sup-
ports a secondary Dante interface, but it is not currently connected.

= Secondary Link Speed: The Ethernet link speed of the secondary interface. Other values are pos-
sible (as per Secondary Address)

Note: A Dante interface may have a preferred link speed. Where it does, and an interface is not
operating at that preferred link speed, the values in the Link Speed columns will be shown in red.
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0 Note: If no device information is displayed for a device, it can indicate a ConMon (Dante control
and monitoring service) failure on the device. The device may need to be reset or restored.

Clock Status
u_’ +7 (= W aoa =) |1 @ @ r") Primary Leader Clocks: Stagebox2-CH, Stagebox1-CH Domain: |ConcertHall L admin {Site Administrator)
Routing Device Info  Clock Status | Network Status  Events
Device . Sync Mute Clock Domain Primaw Primaw Second.arv Secondtarv Preferred Enable Sync
Name Source Status v1 Multicast v2 Multicast v1 Multicast v2 Multicast Leader To External
192.168.20.0/24
Amp1-CH =] Dante Disabled Follower O
Amp2-CH ™| Dante N/A Follower NJA O
Stagebox2-CH ™ Dante Leader Leader Disabled O O
192.168.30.0/24
Desk-CH-Main =] Dante Disabled Follawer Disabled O |
Stagebox 1-CH (=] Dante Disabled Leader Disabled O |

The Clock Status tab provides a network-wide overview of the clocking state within the network.

This view provides a convenient way of quickly scanning the network for clock information. For DDM
networks, devices are grouped into their respective IP subnets.

The tabular view presents the following information, in columns from the left:

Device Name

The device name currently associated with the device.

Sync

Indicates the clock sync status for the device.
"A green IightD indicates that the device is currently synced to (or is driving) the network clock

" Ared light E indicates that the device is not currently synced

Mute

Indicates the mute status for the device.
. Wl
A red mute icon =%+ indicates that the device is currently muted (usually due to loss of clock sync)

= No icon in the mute column means that the device is not muted (audio should be flowing normally)

Clock Source
Indicates the clock source for the device.

= Dante: The device is deriving its clock from the Dante network, or is acting as leader clock (but not
deriving its clock from an external source)

= External: The device is deriving its clock from an external word clock source

Domain Status (DDM networks only)
Indicates the clock's role for its domain.
m | eader: The device is the leader clock for the domain.

= Follower: The device is a boundary clock follower (receiving unicast PTP from a domain leader in
a different subnet).
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= Standby: The device is a backup boundary clock.
= Disabled: The device does not currently have a domain clocking role.

= N/A: The device cannot act as a boundary clock.

See the DDM user guide for more information about domain clocking.

Primary v1 Multicast

Indicates the state of the PTP v1 (Dante audio) clock for the primary interface. Routed DDM networks
will indicate a leader clock for each IP subnet.

® | eader: Device is the current PTP v1 Leader Clock on the primary Dante network
= Follower: Device is a PTP v1 Follower on the primary Dante network

= Passive: Device is not using clock synchronization information from this interface
= Link Down: The interface is not connected to the network

= N/A: Indicates that the device does not support clock status reporting. In the Secondary Status
column, can also indicate that the device is non-redundant.

= |istening: Usually transient. When persistent, it indicates that the device can not operate as a
clock leader (follower only), and is waiting for a clock leader to appear on the network.

Devices that are configured with sample rate pull-up/down are shown with the relevant pull-up/down
value against their Clock Status. For example, a device acting as leader clock with +0.1% pull-up will be
shown as Leader (+0.1%). See About Clock Domains for more information.

Other transient clock states exist, which are not listed above.

Primary v2 Multicast

Indicates the state of the PTP v2 clock for the primary interface, for AES67 or SMPTE-enabled devices.
Possible states are identical to those for Primary v1 Multicast.

Secondary v1 Multicast

Indicates the state of the PTP v1 (Dante audio) clock for the secondary interface. Possible states are
identical to those for Primary v1 Multicast.

Secondary v1 Multicast

Indicates the state of the PTP v2 clock for the secondary interface, for AES67 or SMPTE-enabled
devices. Possible states are identical to those for Primary v1 Multicast.

Preferred Leader
Raises the priority of the device in the leader clock election.

If only one device on a particular clock domain has this checkbox ticked, it ensures that the selected
device becomes leader clock (for that clock domain). When multiple devices have their Preferred Leader
checkbox ticked, the leader will be elected automatically from within that group.

If 'Follower Only' is shown instead of a checkbox, it indicates that the device is not capable of acting as a
leader clock.

Enable Sync To External

Forces the Dante module to derive its clock from an external source - either from a host device word
clock, or from an auxiliary device.

This will also ensure that this Dante device becomes leader clock for the relevant clock domain (unless
another device has 'Preferred Leader' selected). It is not normal practice to configure more than one
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device per clock domain with an external clock source. In this case, the user is assumed to have
synchronized external word clock sources (e.g. house clock).

Where the checkbox is present but greyed-out (and inactive), it means that the Dante device can be
follower to an external word clock, but it cannot be set directly from Dante Controller - it must be done via
the host device user interface, or via some other method (e.g. third-party control software). If the
checkbox is greyed out and populated, it means that the Dante device is currently following the external
clock.

If N/A is displayed, it means that the device does not support slaving to an external word clock.

Note: If no clock status information is displayed for a particular device, it can indicate a ConMon
(Dante control and monitoring service) failure on the device. The device may need to be reset or
restored.

About Clock Domains

Dante Devices that are not configured with sample rate pull-up/down operate on the default clock
domain, using the default clock. Devices that are configured with sample rate pull-up/down operate on
separate 'clock domains', which have their own dedicated PTP clocks, adjusted to account for the pulled
up/down sample rates.

Clock domains are not physically separated, they all exist on the network simultaneously. Devices with
pull-up/down synchronize to the appropriate clock for their pull-up/down setting, and ignore other clocks.
Those devices are shown with the relevant pull-up/down value against their Clock Status in the Clock
Status tab.

Dante devices can only transmit media to, and receive media from other devices on the same clock
domain. For example, a device with zero sample rate pull-up/down operates on the default clock
domain, and cannot transmit media to, or receive media from any devices on the +4.1667% clock
domain, or the -1% clock domain, etc.

Up to 5 separate clock domains can be supported at any one time. All clock domains have their own
leader clock.

In DDM Networks

In DDM networks, each Dante domain typically uses its own special clocking domain (except in the case
of media sharing between domains, when multiple Dante domains will share the same clock domain).

About Leader Clocks

The Dante network leader clock (often also referred to as the 'Primary Leader'), is displayed at all times
in the center of the toolbar of the Network View. This is the device that is providing the time sync source
for all devices on the network.

If multiple clock domains are in use, the leader clock for each domain is shown, in a comma-separated
list.

The leader clock is chosen automatically through an election process, though there are user
configurable parameters that allow prioritization of some devices in the leader clock election.
Configuring a device to have an external word clock source will force that device to become leader
clock, unless another device has 'Preferred Leader' set.

Checking the 'Preferred Leader' flag will always result in that device (or the device with the lowest MAC
address, if more than one device has been checked) becoming leader clock for that domain.
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0 Note: If the leader clock device is not directly visible to Dante Controller (for example, if the leader
clock device is for some reason only connected to the secondary network, and Dante Controller is
only connected to the primary network), the 'Leader Clock' display in the toolbar may show a
MAC address string, instead of the device name.

Clock Status Monitoring

Dante devices are monitored by Dante Controller to establish the status of their clock synchronization
with the Dante network leader clock.

There are two levels of monitoring: 'passive' and 'active'.
In passive mode, Dante Controller will report if a clock loses sync (or regains sync) with the leader clock.

In active mode, Dante Controller will also report if a clock is showing signs of instability. If a device clock
is significantly unstable, it can lose sync with the leader clock, which will result in the device being
automatically muted.

Why would a device clock be unstable?
There are a range of network conditions that can interfere with a device’s clock stability. These include:

= A switch on the network is configured to use Energy Efficient Ethernet ('Green Ethernet') func-
tionality

= A 100 Mb switch or link is present where a Gigabit connection is required
= One or more switches are incorrectly configured

= A'problematic' external word clock is being used as the leader clock

Refer to the Dante FAQs for more information.

Passive monitoring

Passive monitoring is on all the time. If a Dante device loses sync with the leader clock, or regains sync
with the leader clock, it reports the event to Dante Controller. Dante Controller records these events in a
log file, and also will display an alert: the Clock Status Monitor icon (at the bottom right corner of the
main window) will light up red.

Clock Status Monitor:

Clicking the icon opens the Clock Status Monitor, which includes the clock status event log, and a clock
status histogram.

Active Monitoring

When active monitoring is switched on, Dante Controller begins actively monitoring the behaviour of
supported devices to identify signs of clock instability. If a clock exhibits significant instability, the Clock
Status Monitor icon will light up amber, and a warning event will be recorded in the clock status event

log.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -56-


http://dev.audinate.com/kb/webhelp#dante_controller/dante_controller_displayed_a__clock_instability_detected__popup___why_is_this.htm

Dante Controller User Guide /ﬁi Ud i nate®

Clock Status Monitor: [

Click the icon to open the Clock Status Monitor.

Active monitoring is off by default. To activate it, click the Clock Status Monitoring button on the main
toolbar:

When Active Clock Status Monitoring is active, the button is shown in green.

Dante Controller - Metwork View

File Device View Help

To switch it off, click the button again.

0 Note: Active monitoring does not affect passive monitoring.

Which devices are supported?
Dante PCle cards, Dante-MY 16-AUD cards, Ultimo (low channel count) devices and devices that

include a 'Brooklyn II', 'Broadway' or 'HC' Dante module support active monitoring.

Check the Dante Model value in the Dante Information section of the Device View > Status tab to
identify your device type.

Clock Status Monitor

The Clock Status Monitor includes two tabs, Log and History.

Log

The Clock Status log shows time-stamped clock status events for each device that has been identified
as unstable, or has lost or regained sync with the leader clock.
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& Dante Controller - Clock Status Menitor - O >
File Help
Log History
Timestamp Device Hame Event
Apr 01 2016 15:53:17 Stagebox-1 Clock Sync Warning
Apr 01 2016 15:53:16 Stagebox-1 Clock Sync locked
Apr 01 2016 15:53:16 Stagebox-1 Audio UnMute
Apr 012016 15:53:04 Stagebox-1 Clock Sync Unlocked
Apr 012016 15:53:02 Stagebox-1 Audio mute
< >

Save Clear Close

The event types are:

= Clock Sync Warning: Indicates that a clock has been identified as unstable, and is at risk of losing
sync with the leader clock

= Clock Sync Unlocked: Indicates that a device has lost sync with the leader clock. This will result in
the device being automatically muted until it regains sync.

= Clock Sync Locked: Indicates that a device has regained sync with the leader clock.

To delete all Clock Status log entries, click Clear . This will reset the Clock Status Monitor icon to green.

0 Note: This will also clear all other event log entries (the Clock Status log is a filtered view of the
main event log).

Dante Controller will then resume monitoring (unless the Clock Status Monitoring button is switched off).

To save the event log as an xml file, click Save.

History

The History tab can be used to establish the stability of device clocks. It shows a histogram of clock
frequency offset for the selected device, and the current frequency offset value, updated in real time.

The following information is also displayed:
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Mute status

Sync status

External word clock

m Preferred leader status

About Clock Offset

Hardware clocks are based on a vibrating (piezoelectric) quartz crystal. All crystals are slightly different,
and vibrate at slightly different frequencies. When a device (‘follower’) clock wants to sync to a leader
network clock, its frequency must be 'pulled' up or down to match the frequency of the leader clock. The
amount that the clock's frequency is pulled is referred to as 'offset'.

Hardware clocks can only support a certain amount of offset, referred to as 'pull range'. If the pull range
is exceeded, the follower clock will lose sync with the leader clock, and the device will be automatically
muted.

Software clocks typically use an algorithm to derive a clock from an internal counter. Software clocks
can support any amount of offset.

Rapidly-changing offset can also cause a follower clock to lose sync with the leader clock.
Various factors can destabilise follower clocks by affecting their offset, such as:

= QOverloaded network links

= Poorly-implemented EEE (Energy Efficient Ethernet)

= Aleader clock that is derived from an inaccurate external word clock (one that does not run at its
nominal frequency)

About the Histogram

The horizontal axis of the histogram shows the distribution of clock frequency offset measurements
against the nominal frequency of the clock, in parts per million (ppm). The zero point of the horizontal
axis corresponds to the clock's nominal frequency (i.e. the frequency that the clock is intended to run at -
for example, 98kHz).

The vertical axis shows the number of measurements recorded at each data point, on a logarithmic
scale.
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& Dante Controller - Clock Status Monitor —

File Help
Log History
10000
1000 Mute Status:
Unmuted
Sync Status:
100 Locked
External Word Clock:
No
Preferred:
10 No
Frequency Offset:
10 ppm
1
5
(=]
s}
-40 a 40
Save Clear Close

audinate

The histogram is continually updated, with measurements taken roughly once per second.
= To select devices, click the drop-down menu at the top .

= To clear the histogram, click Clear.

= To save a png format screenshot of the current data, click Save.

Interpreting the Histogram

The histogram can be seen as an indication of how much work a follower clock is doing to stay in sync

with the leader clock.

Generally, a stable and accurate clock will show consistently stable offset (with variation in the order of a
few ppm). It means that it is not having to change its offset very much to stay in sync.

Show me

10000

1000

100

10

Counk
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A histogram that shows a distributed range of offsets indicates an unstable clock - it is having to change
its offset significantly, and often, to stay in sync with the leader clock. This can be due to overloaded
network links, or poorly-implemented EEE. A device in this state is highly likely to lose sync with the

leader clock.
Show me
1000
Mute Status:
Unmuted
100 Sync Status:
Locked
External Ward Clodk:
10 No
Preferred:
Mo
Frequency Offset:
1 8 ppm
%
[}
3
-4 ] 40

A histogram that shows measurements in amber and/or red indicates a clock that might be currently
stable, but has little room for manoeuvre; its offset could easily move outside its pull range, at which

point it will lose sync completely. This can result when the leader clock is derived from an inaccurate
external word clock.

Note: Dante Controller can be left running for a few days (or even weeks) to collect clock status
data, providing a long-term picture of the stability of your network clocking configuration.

Show me
10000
Mute Status:
1000 Unmuted
Sync Status:
Locked
100 External Word Clock:
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10 Mo
Frequency Offset:
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Network Status

Routing Device Info  Clock Status  Metwork Status  Events

Device Subscription Primary Secondary Primary Secondary Primary Secondary Latency Latency Packet
Name Status Status Status TxBfW TxBfW Rx B/W Rx B/W Setting Status Errors
Amp-FOH & 100Mbps A < 1Mbps 10 Mbps 2 msec (] (]
Amp-Lobby & 100Mbps J/A < 1Mbps 9 Mbps 2msec D D
Dante-Via-05X & 1Gbps 4 10 msec ol

DV5-PC 1Gbps A < 1Mbps 3 Mbps 4msec (] (W]
FOH-Desk & 1Ghps 1Gbps 72 Mbps &1 Mbps 53 Mbps 58 Mbps 500 usec (] (]
PCle-Record & 1Gbps 1Gbps < 1Mbps < 1Mbps 61 Mbps 61 Mbps 150 usec (W] (W]
Stagebox-1 1Gbps 1Gbps 28 Mbps 28 Mbps 3 Mbps 3 Mbps 250 usec (] (W]
Stagebox-2 1Gbps 1Gbps 28 Mbps 28 Mbps 3 Mbps 3 Mbps 250 usec [ (]

The Network Status tab provides a range of network-related information across all devices in the
network.

This view includes subscription status, bandwidth and latency information, and can be used to quickly
identify any potential network traffic issues. For DDM networks, devices are grouped into their
respective IP subnets.

The tabular view presents the following information, in columns from the left:

Device Name

The device hame currently associated with the device.

Subscription Status

The icon in the Subscription Status column displays a summary of subscription states for the device. If
any of the device's channels are not successfully subscribed, the relevant icon will be displayed here.

See Subscribing to Audio Channels for information about the various icons that can be displayed in the
Subscription Status column.

Primary Status

The Primary Status column indicates the link speed of the primary Dante network interface for the
device.

Secondary Status

The Secondary Status column indicates the link speed and status of the secondary Dante network
interface for the device (if applicable). 'N/A' indicates that the device does not have a secondary
interface. 'Link Down' indicates that the device has a secondary interface, but it is not currently
connected.

Bandwidth Columns

Use the bandwidth columns to see an approximation of transmit and receive traffic over individual
device interfaces.

= Primary Tx B/W

The Primary Tx B/W column displays an approximation of the current transmit bandwidth on the
primary Dante network interface for the device.

= Secondary Tx B/W
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The Secondary Tx B/W column displays an approximation of the current transmit bandwidth on
the secondary Dante network interface for the device.

= Primary Rx B/W

The Primary Rx B/W column displays an approximation of the current receive bandwidth on the
primary Dante network interface for the device.

®m Secondary Rx B/W

The Secondary Rx B/W column displays an approximation of the current receive bandwidth on
the secondary Dante network interface for the device.

Latency Setting
Shows the current latency setting for the device.

Note: Forvideo (Dante AV) devices, the latency setting applies only to the audio channels.

Latency Errors
The Latency Errors column displays icons representing the recent latency performance of the device.

I:' A green light indicates that the device is subscribed, and there are no latency problems - i.e.
all audio packets are arriving well within the device's latency setting.

An amber light indicates that audio packets for one or more channels are arriving at or near
the limit of the device's latency setting. You may need to increase the device's latency, or
reconfigure the network to prevent audio glitches due to packet loss from late-arriving audio
packets.

; A red light indicates that one or more audio packets have arrived outside the device's latency
setting. This will result in audio glitches. The device's latency setting should be increased, or the
network reconfigured (for example, by reducing the number of network nodes in between the
transmitter and the receiver).

H A grey light indicates that the device is not currently subscribed.

Packet Errors

A red light in the Packet Errors column indicates that one or more media packets have been corrupted in
between the switch and the receiver. This is usually due to a faulty Ethernet cable.

Use the Clear Counters button in the Device View > Status tab to clear the packet errors history for a
device.
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Events

Routing Device Info Clock Status  Network Status  Events

Timestamp Device Name Event

Apr 012016 15:21:22 FOH-Desk Elevation to Clock Leader

Apr 012016 15:21:22 FOH-Desk Elevation to Clock Leader

Apr 012016 15:21:18 Stagebox-1 Elevation to Clock Leader

Apr 012016 15:21:18 Stagebox-1 Elevation to Clock Leader
<

Warning i Save Clear Delete old Log files

The Events tab provides information on significant changes and failures in the network.

Dante Controller continually monitors Dante devices and the network as a whole. It is able to watch for
problematic configurations, unexpected problems and communication failures between itself and Dante
network devices. Events are displayed and stored in an event log.

Events fall into one of three categories: Information, Warning and Error.

Filtering the Event List
Use the drop-down menu at the bottom left of the view to filter the events list.

Warning o

F':|:|S:|:|

= \When set to Information, all events are shown.

= When set to Warning, only warning and error events are shown.

= When set to Error, only error events are shown.

Clearing the Event List

To clear the event list, click the Clear button. When new events are detected that match the current filter
setting, they are displayed in the event list.

If you have switched to another Network View tab, new events in the event list will also be indicated by a

red Event Log LED icon E in the Status Bar. Clicking the LED icon will take you straight to the Events
tab and will clear the Event Log LED.

@ Note: The Event Log LED icon will always remain green while the Events tab is open.
Saving the Event Log

To save the event list, click the Save button. The list is saved as a text file with file extension .log. All
events in the list are saved (the filter does not apply to saved events logs).
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Automatic event logging

Events are also continuously written to a log file. Each time Dante Controller is started, it creates a new

log file (with a time-stamped filename, to avoid overwriting previous logs).

audinate

You can find the path to these log files under Help > About. To delete log files more than seven days old,
click the Delete old Log files button.

Event Classification

The following events are classified as Errors:

Invalid link local address

Subnet mismatch on dante interface
Subnet match with non dante interface
Multiple addresses with matching subnets

Subnet conflict of dante interface on primary

Subnet conflict of dante interface on secondary

Unknown address error

Fail Safe Mode

Unknown device issue

Elevation to Clock Leader

Fanout Configuration detected
Mismatched clock pullup subdomain
Wrong subdomain for pullup
Unknown subdomain

Audio mute / Audio unmute

Clock sync lock / unlocked

The following events are classified as Warnings:

Resolution Failed

Elevation to Primary Leader
Multiple external clock sources
Cannot Elevate to Clock Leader

Clock Sync Warning

The following events are classified as Information:

Request Timeout Error
Response Timeout Error
Demotion from Clock Leader
Demotion from Primary Leader

Reboot required
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Automatic Notification of Device Errors

Dante Controller is able to identify several types of problems that a Dante device may experience. A
device that is found to have problems will have its device name displayed in red. Additional information
about the problem can be found by double-clicking on the device.

A device displayed in red will either have entered failsafe mode, or will have an identified issue with its
IP configuration. These states are described in more detail below.

A device displayed in (’'Ultimo’ low channel count devices only) will have entered upgrade mode
(see below).

Incorrect IP address configuration

Dante networks use IP Addressing to communicate. Incorrect address configuration can make it hard or
impossible for a Dante device to communicate. Dante Controller attempts to identify and report several
types of incorrect IP address configuration, including:

= Having multiple DHCP servers on the same network

= |ncorrectly configured static IP addresses

= Connecting the secondary interface of a Dante device to the primary network

= Different interfaces on the same device using the same IP address subnet

= Configuring a DHCP server on the primary network to use the IP address range reserved for sec-
ondary link local devices (172.31.*.%)

If you need further information, please refer to the Troubleshooting section.

Failsafe mode

A device will enter failsafe mode when the firmware image stored on the board has become corrupted.
Although rare, this can occur when:

= The firmware update process is interrupted by power loss or network failure

= The firmware image itself that was used in an upgrade is corrupt

If your device enters failsafe mode, please use the Failsafe Recovery function in the Firmware Update
Manager application (if available) or contact your device manufacturer.

Upgrade mode

When some ‘Ultimo’ devices (technically, those that include an internal Ethernet switch) are upgrading,
or have finished upgrading but have not yet been rebooted, they are in ‘upgrade mode’, and are
displayed in orange text in Dante Controller. While in this mode, an ‘Issues’ tab is visible in the Device
View for the device, indicating their current state.

When these devices have had new firmware applied, they must be ‘manually’ rebooted by the user, via
Dante Controller (unlike other devices which reboot automatically as part of the upgrade process). This
is because any daisy-chained Dante devices downstream of the upgraded device will not receive media
or firmware update data via that device while it is rebooting. The manual reboot option allows you to
control when the device reboots, and thus prevent:
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= |nterruption of media to any downstream daisy-chained devices until it is convenient, and

= |nterruption of firmware update data to any downstream daisy-chained devices that are also in the
process of updating - which in some devices can lead to the update failing, and the device entering
failsafe

When the device has rebooted, media flow to any downstream daisy-chained devices will resume
automatically.

Other Event Notifications

Dante Controller will also notify you of network status, general device events and clock status events,
via the LED icons in the Status Bar.

Device View

The Device View is used to view and modify detailed information and settings for a specific device.
Device view can be activated by double-clicking a device name in any of the Network View tabs (except
Events), or by selecting Device View from the Device menu (Ctrl + D, or Command + D) in the Network
View window. The Device View opens in a new window. Multiple device views can be open
simultaneously.

@ Note: macOS users: Please note that the key combinations shown below are for Windows users.
When using Dante Controller on a Mac, use the 'Command'’ or 'Apple’ key instead of the Ctrl key
when following the instructions below, and substitute standard Mac key combinations where
applicable - see the Dante Controller menus for details.
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& Dante Controller - Device View (FOH-Desk) — | e

File Device View Help

£ N @ < [H & FOH-Desk - )
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The name of the device being viewed is displayed in the middle of the toolbar. In the screenshot above,
FOH-Console is the device being displayed in the drop-down list box.

The device viewed can be changed by selecting another device from the drop-down list.

Multiple Device View windows may be opened from the Network View, so that several devices can be
examined simultaneously.

The Device View displays some or all of the following tabs, allowing you to see different information
relating to a specific Dante device:

= Receive: Display and configure device’s receive (Rx) channels

= Transmit: Display and configure device’s transmit (Tx) channels including multicast
m Status: Device software, clock and network status information

= |atency: View latency histograms (supported devices only)

= Device Config: Rename device, change sample rate and set other attributes (as relevant to device
type)
= Network Config: View and edit network configuration

® |ssues: Displays information for devices in failsafe mode, or upgrade mode (upgrade mode is used
by ‘Ultimo’ low channel count devices only). Not usually visible.

= Baseboard: Only available when the Dante device is mounted on a Dante PDK audio baseboard
(NOTE: the device must be in SPI master mode)

There are also dedicated configuration tabs displayed only for specific devices.
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Device View Menu bar

The menu bar in the Device View contains the following menus:

File

® Close Window

Devices
= Refresh: Refreshes the displayed network / device data
= Create Multicast Flow
= |dentify: Identify the current device by, for example, causing its LEDs to flash.
= Lock/Unlock

®m Clear Domain Credentials

View
® Show/Hide Channel Groups

= View Flow Information

Help
= About: Shows Dante Controller version and current log file
= License: Displays the license text

= Online Help: Opens this HTML user guide on the Audinate web server (requires an Internet con-
nection)

= Offline Help: Opens a locally-stored PDF of this user guide (may not be the latest version of the
user guide)

Device View Toolbar

The Device View toolbar contains the following buttons:

¥, Refresh Re-load routing and configuration information
-’l for the current device.

L Web Config Some Dante devices can be configured via a

h web interface. This button opens a web
browser window which can be used to perform
functions such as firmware upgrades. This
feature is not supported on all Dante devices.

@ Identify Identify the current device by, for example,
causing its LEDs to flash. Note that this
feature is not supported on all Dante devices.

" Multicast Configure multicast transmit flows on the
- current device.
+ Channel Activate / deactivate Channel Groups.
s Groups
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i Device Lock Lock / unlock the device.

The toolbar also provides a drop down list of all available devices on the network, which allows you to
switch the Device View to a different device.

Device View Tabs

The Device View is split into tabs, some of which are only applicable to certain devices. Each tab is
described in detail below.

Receive Tab

The Receive tab displays a list of all subscribed and dormant receive channels on the current device,
plus subscription information for the subscribed channels. It also allows the creation of subscriptions
from the Available Channels list.

& Dante Controller - Device View (FOH-Desk) — O X

Eile Device View Help
() ¥ ® o<| H] .‘; FOH-Desk . (7]

Receive Transmit Status Latency Device Config Metwork Config

Receive Channels Available Channels
Channel Connected to Signal
vox 1 vox 1@Stagebox-1 o= & o A Amp-FOH
vox 2 vox 2@Stagebox-1 o=l du Amp Lobby
quitar 1 quitar 1@5tagebox-1 o= & of FOH-Desk
guitar 2 guitar 2@5tagebox-1 o= d PCLe-Record
bass bass @Stagebox-1 o= & Stagebox-1

keys 1 keys 1@Stagebox-1 o= & [+-Stagebox-2
keys 2 keys 2@Stagebox-1 o= &

MC MC @5tagebox-1 o= & L L
kick kick@5tagebox-1 o= &

snare 1 snare 1@5tagebox-1 o= Y

snare 2 snare 2@5tagebox-1 o= Y

hats hats @Stagebox-1 o= 0 &

ride ride @5tagebox-1 o= 0 &

OHL OH L@Stagebox-1 o= 0 &

OHR OH R@Stagebox-1 o= 0 &

perc perc@stagebox-1 o= G Ly

kit 1 01@5tagebox-2 o= 0 &

kit 2 02@5tagebox-2 o= 0 &

crowd 1 03@5tagebox-2 o= 0 &

crowd 2 04@5tagebox-2 o= 0 &

21

22

23

24

25

26
27

D0DDDVDDDDVDDVDDDDD020D20000

Unsubscribe

The tab is split into two panes: Receive Channels, and Available Channels.

Receive Channels
The Receive Channels pane contains three columns:
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® Channel: Lists the receive channel names for the current device. These can be edited here to
rename the channel.

= Connected To: Lists the Tx channel that the receive channel is currently subscribed to, plus the
status of both primary and secondary subscriptions, using the following icons:

‘1-5.-'

.n.
=

Subscription is OK and media should be flowing

Subscription is unresolved - usually because the transmitting
device has been removed from the network, or is switched off

No subscription, or a subscription error

¥ Subscription is via unicast connection

Subscription is via multicast connection

Subscriptions can show several symbols in the Status column. Common status icon combinations and

their meanings are as follows:

SR

Unicast device successfully subscribed
to a transmitter

Redundant device successfully
subscribed on both primary and
secondary via unicast

Redundant device successfully
subscribed on both primary and
secondary via multicast

Redundant device successfully
subscribed on primary only via unicast.
This is typically seen when the secondary
interface is not connected

= Signal: Supported devices will also show the following channel metering icons, indicating the
presence of audio on subscribed channels:

i

o

Channel is either muted, or receiving audio at less than -61dbFS

Channel is receiving audio between -61dbFS and 0dfFS

Channel is clipping

For video, ancillary and privately-encoded audio channels, supported devices may also show variations
of the following status icons in the Signal column:

.

The signal path (across the network) is good, and there are no

external connectivity problems detected
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G The signal path is good, but Dante Controller cannot ascertain
if there are any external connectivity problems

B The signal path is good, but the Rx device does not support
the signal (for example, because the signal is HDCP and the
Rx device is not HDCP-enabled)

Indicates a signal problem such as an incompatible video
I=x=-I codec, or the Dante subscription is unresolved. Refer to the
subscription status icon for further information.

:I-‘E- = The signal path is good, and the signal is encrypted

Available Channels

The Available Channels pane lists the devices and advertised channels available on the network.
Devices that are greyed out indicate that this receiver cannot subscribe to those channels or devices.
This is typically because of a mismatch in parameters (e.g. sample rate incompatibility etc.), or because
a device cannot route media to itself.

sl

For devices with many channels, you can click the Channel Groups
channels into sets of 16.

button to group available

AES67 Flows

‘Devices’ with multicast IP address names (e.g. 239.69.82.194) are actually AES67 flows, which can
only be received (or transmitted) by AES67-enabled devices.

@ Note: If they are displayed in blue, the currently-selected device is AES67-enabled, and can
receive AES67 flows. If they are displayed in grey, the currently-selected device is not AES67-
enabled.

Creating Subscriptions

Subscriptions are created by selecting a channel from the Available Channels list in the right-hand pane
of the Receive Tab, then dragging and dropping it onto the appropriate receive channel in the left-hand
pane of the Receive Tab.

Multiple channels can be selected and then dragged and dropped onto the Receive Channels pane, to
make several subscriptions simultaneously. You can also drag and drop channel groups to make bulk
subscriptions.

Changing Receive Channel Names
To change a receive channel name, click the name and type in the new value.

Transmit Tab

The Transmit tab is used to inspect and modify the transmit configuration of a device.
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& Dante Controller - Device View (Stagebox-1) — O X

Eile Device View Help

F [
N < H o EE v «*
Receive Transmit Status Latency Device Config Metwork Config

Transmit Channels Multicast Transmit Flows

Channel signal || ¥ Multicast Flow 32: MC

(avox 1 oy
avox 2

{3 guitar 1 oy
{3 guitar 2

(¥ bass oy
(akeys 1
Cakeys 2
MC

o kick

(¥ snare 1
{¥snare 2
(3 hats
Cyride
CVOHL
(JOHR
(¥ perc

A A A A A A A A

Delete

The Transmit Tab is arranged in two areas:

= Transmit Channels: The area on the left pane of the tab shows the Tx channels for the device. It
allows you to edit channel names for transmit channels. Input to the table is filtered to prevent
illegal characters from being used in channel names.

Supported devices will also show the following channel metering icons in the Signal column,
indicating the presence of audio on subscribed channels:

Channel is either muted, or receiving audio at less than -61dbFS
o) Channel is receiving audio between -61dbFS and 0dfFS
) Channel is clipping

For video, ancillary and privately-encoded audio channels, supported devices may also show the
following status icons in the Signal column:

E Indicates there are no external connectivity problems with the Tx
device
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e Indicates there is an external connectivity problem with the Tx
device

L Dante Controller cannot ascertain if there are any external
connectivity problems with the Tx device

= Multicast Transmit Flows: The area on the right pane of the tab shows the multicast transmit flows
that have been configured on the device.

Multicast flows are listed in ID order, including the channels contained within the flow. AES67 and
SMPTE multicast flows are identified as 'RTP' multicast flows, and also include the destination
IP address for the flow.

0 Note: Unicast flow details are displayed in the Flow Information dialog.

Changing Tx channel Names

To change a Tx channel name double click on the name and type in a new one. Tx channel names must
be unique for the device.

Status Tab

The Status tab is used to obtain current information about a Dante device.
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&) Dante Controller - Device View (Desk-room1)

Eile Device View Help

B 8 «<| [{|

Desk-room1 ¥

Receive Transmit St3tus Latency Device Confis  Metwork Config

rDevice Information

Manufacturer: Cyberdyne Systems
Model Mame: T-1000
Product Version: 1.2.3

rDante Information

Dante Model: Brooklyn II
Dante Firmware Yersion: 4.0.9.1
Hardware Version: 4.0.2.7
ROM/Boot Version: 1.3.64

rClock Synchronisation

Mute Status: Unmuted

Sync Status: Locked

External Word Clock: No

Preferred: Mo

Frequency Offset: 10 ppm
rInterfaces

IP Address: 192.168.30.23
MAC Address: 00:1D:C1:06:EA:6C

fer]
(]
=1

-

Tx Utilization: 10 Kbps  Errors: 0
Rx Utilisation: 41 Kbps  Errors: 0

i
%]

audinate

The tab is divided into sections. The information presented on this tab can be very useful when

investigating networking or clocking issues in the system. The Refresh button

update this information if required.

0 Note: Not all Dante devices support the display of all of this information.

Device Information

This provides the following general information about the device:

®  Manufacturer: The name of the device manufacturer.

= Product Type: The type of device.

= Product Version: The product version.

can be used to

= Software Version: The version of the manufacturer software running on the device.

= Firmware Version: The version of the manufacturer firmware running on the device.

Dante Information

This provides Dante-specific information about the device:
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Model: The Dante device type.
Dante Firmware Version: The version of the Dante firmware running on the device.
Hardware Version: The version of the hardware firmware running on the device.

ROM/Boot version: The version of the ROM or bootloader.

Clock Synchronization
This provides the following information about device clocking:

Mute Status: 'Muted' indicates that the device is has been automatically muted (due to a clock syn-
chronisation problem, or because the external word clock is invalid). 'Unmuted' indicates that the
device is not muted, and audio is flowing normally.

Sync Status: 'Locked' indicates that the device is locked to the network PTP clock. 'Not Locked'
indicates that the interface has not achieved lock with the network PTP clock.

External Word Clock: 'No' indicates that the device has been configured to use the internal clock
source. 'Yes' indicates that the device has been configured to accept an external word clock
source. NOTE: If the Dante device is configured to accept an external word clock source, it is
important to make sure that the host equipment has been configured to provide its word clock to
the Dante device. Check your product manual for more information.

Preferred: 'No' indicates that the card has not been set to preferred leader mode. 'Yes' indicates
that the card is set to preferred leader mode.

Frequency Offset: Indicates the offset from the network clock leader measured in parts-per-mil-
lion.

Primary Interface
Provides the following information about the primary network interface:

IP address: The IP address currently assigned to the interface

MAC address: The Media Access Control address of the interface, associated with the Ethernet
layer

Tx Utilization: Shows the current total transmit bandwidth in use

Errors: (on the same line as Tx utilization) shows the number of transmit Cyclic Redundancy
Check (CRC) or packet errors detected since the device was last started

Rx Utilization: Shows the current total receive bandwidth is use

Errors: (on the same line as Rx utilization) shows the number of receive Cyclic Redundancy
Check (CRC) or packet errors detected since the device was last started

Note: The Rx Utilization includes not only network traffic destined for the Dante device, but any

other multicast or broadcast traffic received at this network interface.

Note: As a rule of thumb neither the Rx nor the Tx utilization should exceed about 85% of the link

speed in order to guarantee good clock synchronization performance (links are full duplex).

The graphic also indicates the speed and connected state of the interface as follows:
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Indicates that the link is operating at 1Gbps

Indicates that the link is operating at 100Mbps

Indicates that the link is not connected, or that there is an
error. The IP address will read N/A, and Tx and Rx utilization
will be 0 kbps.

Clear Counters: Click this button to reset the packet errors history for the device.

Secondary Interface

This provides the same information for the secondary interface that is provided for the primary interface,
as described above.

0 Note: The secondary network interface will only be displayed if the device supports redundancy.

Latency Tab

For supported devices, the Latency tab displays histograms of audio packet latency for each transmitter
that the device is subscribed to.

0 Note: Forvideo (Dante AV) devices, latency settings made in Dante Controller apply only to the
audio channels.

Which devices support latency monitoring?
Newer Brooklyn Il, Broadway, HC, PCle and Ultimo devices support latency monitoring in Dante
Controller. You can check your device type in the Device Info tab.

About Latency and Packet Loss

Latency is used to account for the delay between an audio packet leaving the transmitter, traversing the
network (potentially through multiple switches) and reaching the receiver.

If a receiver's latency setting is too low, audio packets will not have time to get from the transmitter to the
receiver before they are supposed to be played out. When this happens, the receiver will drop packets
(i.e. it will throw packets away, because they are 'late to the party').

Packet loss results in audio glitches, so it is very important to ensure that all receivers have their latency
set high enough to prevent packet loss.
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Setting device latency too high, however, can interfere with low-latency applications (for example, real-
time monitoring when recording vocals), so it is sometimes important to find a balance between low
latency and guaranteed audio integrity.

The Latency tab can be used to identify:
= Devices that are dropping packets because their latency is set too low
= Devices that are at risk of dropping packets because their latency is set too low
= Devices that could potentially have their latency reduced (if required; generally, the default Dante
latency of 1ms is more than adequate for low-latency applications)
About the Histogram

The transmitter's name is displayed at the top of the histogram, along with the latency value against
which the histogram is reporting.

The horizontal axis shows the distribution of audio packet latency measurements from the transmitter.

The vertical axis shows the number of measurements recorded at each data point, on a logarithmic
scale.

Measurements are taken at roughly 1 second intervals, from when Dante Controller is started.

Stagebox2 @ 1 msec

1000
Setting:
1 msec
100 Peak:
645 usec
Average:
i0 | 402 usec
Late:
i
1 -— - -
5
L}
i

0 Latency 0.5 1

To clear the histogram, click Clear. Latency measuring will then restart.
To save the histogram as a png image, click Save.

Note: If any subscriptions are via multicast flows, there may be two histograms displayed for one
transmitter: one histogram for the unicast flows, and one for multicast. This is because multicast

flows always use a latency of 1ms. If the receiver is set to a latency other than 1ms, two histograms
will be displayed.

The following information is also displayed:
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= The latency Setting for the histogram. In most cases, this will be the same as the latency setting

on the receiver. However, for some subscriptions, Dante will automatically apply a different
latency. For example:

° Multicast flows are automatically set to a minimum of 1ms

o If a transmitter does not support the latency set on the receiver (i.e. it can't guarantee delivery
within the required latency), Dante will increase the latency to the lowest setting supported by
the transmitter. Ultimo devices, for example, support a minimum latency of 2ms, so sub-
scriptions to Ultimo devices will use a minimum of 2ms latency.

® The Peak latency since measuring started
= The Average latency since measuring started

= The number of measurements taken that included one or more Late packets (note that each meas-
urement typically includes many packets)

Interpreting the Histogram

If all bars are green and falling well within the limit of the histogram (i.e. towards the left or middle of the
histogram), it indicates that the latency setting for the receiver is set high enough to prevent packet loss.
Show me

Stagebox1 @ 250 usec

1000

100

Counk

0 Latency 125 250

If any bars are amber, it means that some packets are arriving near the limit of the latency setting.
Network traffic fluctuations could potentially lead to extra delay which could cause packets to arrive late.
A histogram of this type indicates that the receiver latency should be increased if possible.

Show me
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Stagebox1 @ 250 usec

1000

100

10

Counk

0 Latency 125 250

If any bars are red, it indicates late packets, and audio loss. The receiver latency should be increased, or
the network reconfigured.

Note: Dante Controller can be left running for a few days to collect latency data, providing a long-

term picture of the latency performance of your network configuration. This is especially useful after
any network infrastructure upgrades, or after the addition of more end point load in a given network,

to determine if QoS tuning or increased capacity may be required at the network switch level.
Show me
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Stagebox1 @ 250 usec

1000
100
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5
]
0
0 Latency 125 250
Device Config Tab

This tab on the device view window allows you to configure device specific parameters. The specific

options available will depend on the capabilities of the device. In the case where a device does not
support configuration via Dante Controller, the tab will be disabled.
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& Dante Controller - Device View (Desk-Studio) — ] x
Eile Device Miew Help

£ 0N E < 1 & Desk-Studio v 7]

Receive Transmit Status Latency Metwork Config  AES67 Config

rRename Device

Desk-Studio Apply
rSample Rate

Sample Rate: |48k o Pull-up/down: |NONE -~
rEncoding Clocking

Preferred Encoding: |PCM 24 w Unicast Delay Requests: |Disabled ~

rDevice Latency

Latency: | 1.0 msec e

rReset Device

Reboot Clear Config

Configurable Parameters
Rename Device

Allows you to enter a new Dante 'friendly name' for the device. The text field displays the current name.
To change the device name, enter a new name in the text field and press Enter.

See Device and Channel Names for information about name conflicts and device name rules.

Sample Rate

= Shows the current sample rate of the device, and allows you to change the operating sample rate
of the Dante device. This may require the device to be rebooted to take effect. All sample rates sup-
ported by the device are shown in the drop down menu.

= Shows the current pull-up/down setting for the device, and allows you to change the pull-up/down
setting. The pull-up/down setting can be used to adjust the sample rate of the device to syn-
chronise audio with video that has undergone frame rate conversion. For example, to synchronise
Dante audio with video that has been converted from 24 fps to 25 fps, set the sample rate pull-up/-
down for any relevant Dante audio devices to +4.1667%.

= Applies to audio channels only.
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@ Note: Changing the sample rate pull-up/down for a device places that device in a dedicated clock
domain. Dante devices can only transmit audio to, or receive audio from other devices on the same
clock domain. See Clock Status View for more information.

Preferred Encoding

Shows the current preferred encoding setting and allows you to change the preferred encoding setting
for the device.

Applies to audio channels only.

@ Note: This setting does not guarantee that the device will use always the selected encoding: Both
devices must support the selected encoding for it to be used.

Unicast Delay Requests

Delay requests are messages sent by clock followers to the clock leader to establish the time it takes for
data to traverse the network between the devices. By default, delay requests are multicast messages,
and in networks with lots of devices, they can add up. Enabling 'Unicast Delay Requests' forces clock
follower devices to send delay requests to the clock leader using unicast instead, which reduces
multicast traffic.

@ Note: Unicast Delay Requests does not have to be enabled on the clock leader, only on the clock
followers.

O Important: Some older Dante devices do not support Unicast Delay Requests. Before enabling the
feature for your clock followers, check that your current clock leader supports the feature, by
attempting to enable it for the device. If the clock leader device does not support unicast delay
requests, do not enable it on your clock followers (it may prevent your devices from synchronizing).
You can however choose an alternative clock leader that does support it, and then enable it for the
clock followers that also support it.

Device Latency

Shows the current device latency setting, and allows you to change the operating receive latency for the
selected device. Select a value and click OK to apply the latency to all flows that the device is receiving.

Applies to audio channels only.

@ Note: The 150 psec setting is unavailable for devices that include an internal network switch.
@ Note: Device latency cannot be configured for Dante Via devices.

@ Note: Devices enrolled in a Dante domain may support extra latency values.
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Warning: Changing the latency value will cause disruption in the audio while the flows are re-
established at the new latency setting.

Reset Device

Allows you to remotely reboot the Dante interface, and also to reapply factory settings (Factory Reset).
Rebooting the Dante device may also require a reset of the host audio equipment containing the device.

Factory Reset wipes the following device configuration settings:
= User-defined device name
= User-defined channel names
= Clock configuration (clock leader / external clock leader setting)
®  Static IP addresses
= Redundancy configuration
= Sample rate setting (including pull-up/down)
® | atency setting
= Any existing audio routes
Supported devices allow you to 'Clear Config' instead of Factory Reset. Clear Config wipes the same

configuration settings listed above, but allows you to optionally keep the IP settings (i.e. retain the Dante
Redundancy settings, and any static IP addresses currently configured in the Network Config tab).

A reboot is required after clearing the configuration for the changes to take effect. Some devices will
allow you to automatically reboot after clearing the configuration. If this option is not available, a manual
reboot is required.

& Clear Configuration pd

| Kieep Metwork Configuration
p g
[ ] Reboot

Ok Cancel

Plugins
Some devices may present additional 'plugin’ tabs, defined by the device manufacturer, for configuration
and display of additional device settings, such as video format and/or ancillary channel settings.

The contents of these tabs will vary based on the controls and information that the device manufacturer
has chosen to expose.

Refer to the user guide for your particular device for more information.

An example Video Config plugin tab is shown below.
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& Dante Controller - Device View (DANTEAV-02208¢-RX) - O X

File Device View Help

£ 8 ® e ™ DANTEAV-02208¢-... < )

Receive Transmit Status Latency Device Config

Serial Config MNetwork Config

rVideo Reference Settings

Video Resolution: | Auto v
Color Space. | Auto v
Bit Depth: | Auto v

Compression Profile: ® Broadcast

Ulira Low Latency

Quality: | Levels v

~HDMI, HDCP Status

@ Valid non-HDCP signal

Direction. RX
Current Setting:  1080p (1920x1080)
RGE 444
2 bit
| Save |

Network Config Tab

Use the Network Config Tab to toggle supported devices between Redundant and Switched modes, and
to specify static IP addresses for a device's Ethernet ports.
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& Dante Controller - Device View (FOH-Desk) - m] *x

File Device View Help

o B E < H @ FOH-Desk v <«

Receive Transmit Status Latency Device Config Metwork Config

rDante Redundancy:

Current: Redundant

New: Redundant -

rAddr

Primary Secondary

(®) Obtain an IP Address Automatically (default) (@) Obtain an IP Address Automatically (default)

() Manually configure an IP Address (O Manually configure an IP Address
1P Address: . . . IP Address:

Netmask: . . . Metmask:

DMS Server: . . . DNS Server:

Gateway: . . . Gateway:

Revel
rReset Devic
Reboot | | Clear Config |

Dante Redundancy / Switch Configuration

Depending on the manufacturer's configuration of a device, it may be possible to toggle the device
between Redundant and Switched modes, or to select a Switch Configuration.

Redundant

When a device is set to Redundant, the device will duplicate Dante media traffic to both Ethernet ports,
allowing the implementation of a redundant network via the secondary port. Not all devices support
redundancy.

Switched

When a device is set to Switched, the secondary Ethernet port will behave as a standard switch port,
allowing daisy-chaining through the device.

Switch Configuration

Certain devices support specialist switching and/or redundancy configurations for the Ethernet ports.
For these devices, the top pane of the Network Config tab will be titled 'Switch Configuration'. Please
refer to the manufacturer's technical documentation for information on the supported switching
configurations for the device.

Addresses

Dante devices obtain IP addresses automatically by default, and in the vast majority of circumstances
there is no need to change the Addresses settings. However, static IP addresses can be assigned if
necessary.

To assign a static IP address:
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1. Select 'manually configure an IP Address' for the appropriate Ethernet port.

2. Enterthe IP Address and Netmask.

3. Click Apply.
The DNS Server and Gateway settings are optional - the device will use network defaults if they are not
specified.

Click Revert to revert back to the previous settings.

@ Note: Assigning static IP addresses requires a device reboot.

Interop Status Tab
For enrolled devices in a DDM network, the Interop Status tab shows the current interoperability mode
for the device:

®  SMPTE: The device is enrolled in a SMPTE domain, and is configured in DDM to enable
RTP flows

= AES67: The device is enrolled in an AES67 domain, and is configured in DDM to enable
RTP flows

= None: The device is enrolled in a standard Dante (non-RTP) domain

The RTP multicast destination address prefix is also shown for devices in SMPTE or AES67 mode.
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& Dante Controller - Device View (Desk-5tudio) — a hd

Eile Device View Help
< N < 1. Desic-Studio __ ¥ 2]

Receive Transmit Status Latency Device Config  Network Config  Interop Status

Interop Status

Mode: SMPTE
Destination Address Prefix: 239, 69.)00( XXX

AES67 Config

For supported devices (Brooklyn 11 v3.9.x devices and up), the Device View also includes an AES67
Config tab. The AES67 Config tab allows the selection of AES67 mode for the device.
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o Dante Controller - Device View (BKLYN-1I-065790) - 0 &3
File Device View Help
&5 BN @ «<| |+ a v Q

Receive | Transmit | Status | Latency | Device Config | Network Config | AES&7 Config

FAESET Mod

Current:  Enabled

Mew: |Enabled

rRTP Multicast Address Prefix

Current Prefix: 239, 30,000,000

Mew Address Prefix: Set

rReset Device

Reboot Clear Config

AES67 is a standard for audio over IP interoperability.

Devices in AES67 mode are able to transmit and receive AES67 multicast flows to / from non-Dante
AES67-enabled devices. Between Dante devices, Dante's native audio transport protocol is
used instead (even when AES67 is enabled for both devices).

0 Note: When the device is enrolled in a domain, AES67 configuration is controlled via DDM
instead, and the AES67 tab is not available.

AES67 Mode
Select Enabled to enable AES67 mode for the device.

Use the Create Multicast Flow panel to create AES67 flows.

RTP Multicast Address Prefix

You can use the RTP Multicast Address Prefix field to specify a multicast subnet, for cases where you
need to transmit to or receive from a particular address range.

The multicast address prefix set at device level does not affect which AES67 flows from non-Dante
devices are displayed in Dante Controller. However, when subscribing a Dante device to a non-Dante
Tx flow, the multicast address prefix set for the receiver must match that of the Tx flow. If they do not
match, the subscription will appear to succeed, but audio will not actually flow.
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0 Note: Dante devices are able to transmit AES67 flows on any IP address. However, some devices
(specifically, Brooklyn II, HC and Broadway-based devices) will only subscribe to AES67 flows in
the 239.x/16 address range. If you need to subscribe any of these Dante device types to an AES67
flow from a third-party device, ensure that the transmit flow is in the 239.x/16 address range.

0 Note: Presets do not support AES67 flows.

Controls Tab
For supported devices, the Device View also includes a Controls tab. Use the Controls Tab to adjust
audio controls for the selected device.

The displayed control set varies between devices.

@ Dante Controller - Device View (AVIOAQ1-5000ca) - m] *

File Device View Help
“ 08 @ Ha [AVI0A01-5000... 1% 7]

Receive Status Latency Device Config Metwork Config AES67 Config Controls

Output Level

Channel 1: | +4dBu (default) -

HA Remote Tab

For supported devices (Dante-MY16-AUD cards v3.3.9 and up), the Device View also includes an
HA Remote tab. The HA Remote tab allows the selection of the HA Remote bridging mode for the
device.
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& Dante Controller - Device View (Dante-MY16-AUD1) — ] e

Eile Device View Help
£ 0 @ < H a Dante-MY16-AU... o

Receive Transmit Status Latency Device Config Network Config HA Remote

HA Remate Bridging Mode

O Mode 1: Slot < DB9 Active, Network Inactive
® Mode 2; Slot ¢ Network Active, DBS Inactive
O Mode 3: DBS <= Netwark Active, Slot Inactive
O Mode 4: All Inactive

HA Remote is a proprietary serial control protocol used by Yamaha products. For more information
about HA Remote bridging modes, please download the latest version of the Dante-MY16-AUD user
guide from the Yamaha website.

Avid Config Tab

For supported devices (DNT-192 expansion cards), the Device View also includes an Avid Config tab.

The Avid Config tab allows the configuration of the DNT-192 card, and displays relevant firmware and
hardware version information.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -91-



Dante Controller User Guide /ﬁi Ud i nate®

o Dante Controller - Device View (DNT-192-06ea2?2) - 0 &3
File Device View Help
€3 B8 ®©| e<| |+ a v G

Receive | Status | Latency | Device Config | Metwork Config | Avid Config

révid Dante Card Information

Application version: 0.6
FPGA Version: 1.9
Board Version: 2

ravid Rack Skatus Information

Rack Sample Rate: 48k
Rack Mute Status: OFF

révid Dante Card Contral

Card Configuration: | Input Card
SRC: EMABLED
Card Identity: |\Dante  w

The tab includes 3 sections:
= Avid Dante Card Information: Displays information about card hardware and software versions
= Avid Rack Status Information: Displays information about the rack status for the card

= Avid Dante Card Control: Allows the configuration of various DNT-192 settings

Avid Dante Card Information
This section displays:

Application version

The version of the Dante application currently installed on the DNT-192 card.
FPGA Version

The version of the FPGA binary on the card.

Board Version

The hardware version of the card.

Avid Rack Status Information
This section displays:
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Rack Sample Rate

The sample rate at which the rack is currently set to.
Rack Mute Status

The mute status of the rack.

Avid Dante card Control
This section allows high-level configuration of the DNT-192 card.

Card Configuration

In ‘Dante’ mode the card configuration is automatically set by the rack. In ‘Generic’ mode the
configuration is manually selectable.

The Card Configuration option supports 3 values:
® |nput card: The card functions as a 16-channel input device
= Qutput card: The card functions as a 16-channel output device

= |nput/Output card: The card functions as an 8-in + 8-out device
SRC

Sample Rate Conversion.

When enabled, the card will convert incoming (Rx) audio to the Rack Sample Rate (if required), and
outgoing (Tx) audio to the sample rate of the receiving device on the Dante network (if required).

Note that SRC adds latency of roughly 1.3ms to the Dante subscription in each direction.
Card Identity

= Dante: The card will identify itself as a Dante device to the host device rack, enabling Dante func-
tionality on the host device. Required for Dante-enabled host equipment.

= Generic: The card will identify itself as a generic digital audio interface (required for non-Dante
host equipment).

Flow Information

The Flow Information dialog displays any audio, video or ancillary flows to and from the device .

To open the Flow Information dialog, open the Device View for the device and select View > View Flow
Information.

In the example below, the device supports 32 audio transmit flows and 32 audio receive flows.
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& Flow Information Summary #

-Transmit Flows

Inicast: 1 Multicast: 1 Total: 2 of 32

-Receive Flows

Total: Fof 32

Close

Multicast Transmit Flow Configuration

Click the 'Create a new multicast flow' button in Device View to open the Create Multicast Flow dialog.

.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -94-



Dante Controller User Guide /ﬁi Ud i nate®

W& Create Multicast Flow >

Desk-CH-Main supports up
to 64 channels per flow.

RTP flows for AESET have a maximum of 8 channels per flow,

Select ane ar mare transmit channels to be placed in multicast flows.

Flow Config (Optional)

(@) Dante () AESET
Maximumlnumber of 4 "
channels in the flow:

Channel ] Add to
Name New Flow
3 vox 1 A
K3 ovox 2

3 guitar 1

£ guitar 2

(3 bass

3 keys 1

(3 keys 2

9 kick 1

Ko kick 2

&3 snare 1

&3 snare 2 |

3 hats |

3 ride |

{3 crash O
(30OH1 |
(30OH2 |

i percl O v

Create Cancel

The dialog displays a list of the Tx channels for the device.

To add channels to a multicast flow, select the checkboxes for the channel name. Once you have
selected all the channels required, create the multicast flow by clicking the Create button at the bottom
of the dialog box. To abandon creating a new multicast flow, click Cancel.

Once a flow has been created, it will appear in the list of flows in the transmit pane, along with the
channels contained within that flow. Channels cannot be added to or removed from existing flows. Each
time the dialog is used to select additional channels, a new multicast flow will be created.

By default, Dante receivers will connect to a multicast flow if one exists that contains the required
channel(s), rather than creating a new unicast flow.

If a channel that does not form part of an existing multicast flow is added to a new multicast flow, any
existing unicast subscriptions to that channel will automatically switch over to use the new multicast
flow.

A good rule of thumb is to use multicast when there are more than two receivers for a specific media
channel. You should also assume that the flow will flood throughout the entire network, and therefore
consume bandwidth on all network links.
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0 Note: Some ancillary channel types for video (Dante AV) devices cannot be added to multicast
flows.

Maximum Channels per Flow (Audio Devices Only)
The number of channels that can be added to a Dante multicast flow varies by device type. This is
displayed at the top of this window, and is 64 channels for the device shown above.

If you select more channels than the maximum supported channels per flow, multiple flows will be
created. For supporting devices, you can restrict flows to fewer channels if required, using the drop-
down menu in the Flow Config section.

This control also affects the number of audio samples per packet:

Maximum Channels Setting Samples per Packet

16 16
32 8
64 4

Smaller packet sizes may enable lower device latency settings for relevant subscriptions - use the
Latency tab in Device View to monitor latency performance.

0 Note: Dante devices on legacy (pre v4.2 firmware) will reject a 'create multicast flow' operation
with more than 8 channels.

0 Note: Video flows support only 1 video channel.

Managing Flow Size

Multicast flows propagate through the network to every device that requests one or more of the channels
in the flow. When considering network traffic management, in a typical network where no devices
actually need all channels, it would be more advisable to create multiple flows than it would to create
one flow containing all channels.

In the first example illustrated below, one multicast flow was created, containing four channels. None of
the devices actually require all four channels, but both switches are processing four channels of traffic.
In the second example, two flows were created with two channels each. All devices are receiving the
channels they need, but the switches are processing half the traffic.
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Figure 1 - Single multicast flow with all channels
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Figure 2 - Two multicast flows, with half the number of channels in each

Deleting Multicast Flows

Care should be taken when deleting a multicast flow, as the existing subscriptions will convert back to
unicast. This has the potential to result in exceeding the link capacity or maximum number of flows at the
transmit device, as multiple unicast flows will be established between the transmitter and its receivers. It
may be advisable to remove some or all of the media routes prior to deleting the multicast flow.
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Note: Certain Ethernet switches support IGMP (Internet Group Management Protocol), a protocol
that provides the ability to 'prune’ multicast traffic, so that it travels only to those end destinations
that require that traffic. If this is the case, and IGMP is correctly configured on all the Ethernet
switches, then multicast media will not flood throughout the network, but will instead be sent only
over the links required to deliver it to subscribed devices.

AES67 Flow

The AES67 Flow option is only available for AES67-enabled devices.

When AES67 Flow is checked, the selected channels will be added to an AES67 multicast flow. Only
AES67-enabled devices can receive AES67 flows. Dante devices cannot subscribe to AES67 flows from
other Dante devices.

RTP transmit flows (including AES67 flows) from non-Dante devices appear in blue at the far right of the
Routing tab of the Network View, and at the bottom of the Available Channels list in the Device View >
Receive tab. AES67 flows are identified by their transmit multicast IP addresses, rather than device
names.

For AES67-enabled Dante devices, each device transmit channel can simultaneously support an
AES67 multicast flow and a standard Dante multicast flow.

AES67 flows support 8 channels. If more than 8 channels are selected for an AES67 flow, multiple flows
will be created.

Note: Dante devices are able to transmit AES67 flows on any IP address. However, some devices
(specifically, Brooklyn Il, HC and Broadway-based devices) will only subscribe to AES67 flows in
the 239.x/16 address range. If you need to subscribe any of these Dante device types to an AES67
flow from a third-party device, ensure that the transmit flow is in the 239.x/16 address range.

SMPTE Flows

For DDM networks, supporting devices that are enrolled in a SMPTE-enabled domain can transmit and
subscribe to SMPTE ST 2110-30 flows.
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Creating SMPTE Flows

& Create Multicast Flow

rFlow Canfig (Optional)

Stagebox-CH supports up
to 64 channels per flow.

Select one or more transmit channels to be placed in multicast flows.

(O Dante @ SMFTEA (O SMPTEE () SMPTEC

Packet time: 1msec
Destination Address: () Auto (®) Manual
1 Address: =3
Channel ] Add to
Name New Flow
01
02
03
04
a5 D
[l I:l
a7 I:l
o3 I:l
Create Cancel

audinate

SMPTE flows created in Dante Controller are advertised on the network via SAP/SDP.

0 Note: Refertothe SMPTE Standard (SMPTE ST 2110 -30:2017) for more information about
SMPTE audio. Refer to the DDM User Guide for information about configuring RTP domains.

To create a SMPTE flow:
1. Open the Device View for the device and click the 'Create a new multicast flow' button.

2. Select the required SMPTE flow config.

o SMPTE A: 48 kHz flow with up to 8 channels at packet times of 1ms
°© SMPTE B: 48 kHz flow with up to 8 channels at packet times of 125us
°o SMPTE C: 48 kHz flow with 64 channels at packet times of 125us
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3. Forthe Destination Address:

o Select 'Auto' to automatically assign the destination address and port number. The des-
tination address will be assigned according to the RTP prefix configured for the domain in
which the device is enrolled. For example, if the RTP prefix for the domain is 69, the
device will create a flow with destination address of 239.69.x.x. The port number defaults
to 5004.

o Select 'Manual' to specify the address and port. The IP address must be in the range
239.0.0.0 t0 239.254.254.254. The port can be set to any non-administrative port num-
ber.

4. Select the channels to be added to the flow, and click ‘Create’. If the number of selected channels
exceeds the maximum number supported by the config, multiple flows will be created.

The transmit flow will present in the controller software for your SMPTE receiver if it natively supports
SAP/SDP parsing. If not, an alternative mechanism will be required to parse the SDP descriptor for the
flow. The configuration of third-party SMPTE receivers is specific to the receiver.

Note: Renaming a Dante device will also rename any SMPTE flows from that device.

Subscribing to SMPTE Flows

SMPTE transmit flows from non-Dante devices present in Dante Controller as Dante transmitters with
blue 'device' names. The device name is taken from the SDP descriptor for the flow as advertised by the
device, or configured in Dante Domain Manager.

SMPTE channels can be subscribed to (by supporting devices) in the same way as channels from other
transmitters.

If the transmitter does not advertise flows via SAP/SDP, you can use DDM to generate a 'proxy"
RTP session with a descriptor that is supported by Dante Controller.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -100-



Dante Controller User Guide

audinate

Routing  Device Info  Clock Status  Mebwork Status  Events

o TIxxEYOT I~z
apan TT9EEEST0 /5
= - T FE =2 E =
B (= :ﬁa.gruu.l
EE@S S L2 E
Filter Transmitters w == I ¥ i L ﬁlE
]
] EED Hlo W
L ﬁl [==
= = o ¥
E o =
Filter Receivers E =] 2
o =
= p
a1]
!
c
m
=
[+/[=| Dante Receivers
BAmp1-ch 2RI IR IUILl
[+ Amp1-Restaurant
[+ Amp2-CH U ErNEEEEEEEEA
[+ BII-PDK
|~ Desk-CH-Main
vox 1
vox 2

— =]
=

0 Note: The PTP v2 clock domain configured for the domain in DDM must match that of the flow. If
they do not match, when you attempt to subscribe to the flow, Dante Controller will report 'Clock
domain mismatch'.

=l |
HENEEEEEEEEEEEEEEEEEEE .

Cannot subscribe: Clock domain mismatch

0 Note: The RTP Prefix configured for the domain in DDM must match that of the flow. If they do not
match, subscriptions will appear to succeed but audio will not flow.

For more information about SMPTE domain configuration and SDP descriptors, refer to the DDM user
guide.
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Using Dante Controller with Dante Domain
Manager

About Dante Domain Manager

Dante Domain Manager (DDM) is a complete management solution for Dante systems.

With DDM, integrators can define specific AV device groupings, by room, building and site, allowing for
the creation of independent Dante Domains, and enabling a single Dante Domain to encompass
multiple network subnets.

DDM provides robust security for IT departments and AV managers, including user authentication and
encrypted control, role administration and integration with Active Directory. System managers gain
complete visibility and accountability with a suite of dashboards, audit trails, alerts and SNMP support.

DDM is a virtualized application that runs on desktop and server platforms, with an intuitive and highly
responsive web interface for desktop, tablet and mobile browsers.

For more information about DDM, refer to the DDM user guide.

0 Note: DDM does not currently support video (Dante AV) devices.

Viewing Domains in Dante Controller

To view enrolled devices in Dante Controller, the user must connect to the DDM server using their
configured DDM credentials, and then select the appropriate domain for viewing.

Connecting to a DDM Server

To connect to a DDM server:

[
E
1. In the Dante Controller toolbar, click the Domain Manager Login button: i]

The Domain Manager Login dialog is displayed.

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -102-



Dante Controller User Guide /ﬁi Ud i nate®

& Domain Manager Login pd
Server Mame or IP Address: Fort:
192, 158, 20, 34 3443

[ ] Auto-Detect Server

=zer name:
roy-batty
Password:

.

Login Disconnecteq Cancel

2. Inthe Domain Manager Login dialog, either:
® Select 'Auto-Detect Server' to search for a DDM server automatically*, or:

® Enter the relevant server name** (FQDN) or IP address, and the port number.
3. Enter your user name and password.
4. Click Log in.

* Auto Discovery requires DNS if Dante Controller and the DDM server are in different IP subnets.
** Requires DNS.

First-time Connections

The first time an installation of Dante Controller connects to a DDM server, a pop-up dialog is displayed:

& Domain Manager Login x
This is the first time you have connected to the Dante Domain Manager from this machine.
The fingerprint of the Domain Manager is:
sha256/ [FX6Rmz93ChHLOWL+ 3ilXCGzET65MgkilwjT7g2VL2to=

Would you like to proceed?

MNo

Click Yes to connect to the DDM server, or No to cancel the connection.

This security mechanism enables you to verify that the DDM server at the specified server name /
IP address is the server to which you actually intended to connect.

If the underlying DDM server at a previously used server name / IP address changes, you will see a
warning pop-up, so you can cancel the connection if required.

The fingerprint is a unique ID for the DDM server, and is saved locally to your computer.

You can view known fingerprints in the ddm_hosts file at:
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= Windows: C:\Users\<user name>\AppData\Local\Dante Controller
® macOS: ~/Library/Application Support/Dante Controller

You can also view the fingerprint for a DDM server instance in the Network & Security settings of the
DDM user interface.

Viewing a Domain
To select a domain for viewing, select the required domain from the Domain drop-down menu in the
Dante Controller main toolbar.

The domains and devices you are able to view and configure are determined by your DDM user account
privileges.

& Dante Controller - Network View = O X

File Device View Help

U_l ¥ @ | ol & [EH @ @ r‘j Primary Leader Clock: Desk-FOH Domain: | Concert Hall ~| L admin (Site Control) 9

Routind  Device Info  Clock Status  Metwork Status  Events
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+/Amp1-FOH + [ [ [ [ EE o~
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+/Stagebox-2 H FHEHEEEHEE
w
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P I s [ 8 devices Multicast Audio Bandwidth: 0bps Eventlog: [] Clock Status Monitor: []

The currently logged in user and their relevant domain privileges are displayed next to the Domain drop-
down menu.

0 Note: When connected to the <unmanaged> domain, Dante Controller will only display devices in
the local subnet.

Connecting Devices to a Domain Manager

For networks in which DDM is unable to automatically discover all devices in your Dante network - for
example, multi-subnet systems without a DNS server - you can 'connect' your devices to DDM so that
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they appear in the DDM web interface, and can be more easily enrolled into domains.

This function forwards the DDM server address to your devices, so they can advertise their presence on
the network to DDM.

It is a convenient alternative to enrolling devices by IP address.
To connect your devices to DDM:
1. In Dante Controller, from the Devices menu, select 'Connect Devices to Domain Manager'.

The 'Connect Devices to Domain Manager' dialog is displayed:

& Connect Devices toc Domain Manger >
Server Mame or IP Address: Port:
192,168.20.34 anoa

Select devices to configure:

-
I o TRy
—'I'\— g

Desk-CH-Main s
Desk-CH-Monitors
Stagebox1-CH
Stagebox2-CH
W
All Mone
Ok Cancel

2. Enter the Server Name* (FQDN) or IP address of the DDM server, and the port number.
The devices in your network that are currently visible to Dante Controller are displayed.

3. Select the required devices and click Ok. You can use the 'All' or 'None' buttons to select or
deselect all devices in the list.

* Requires DNS.

0 Note: Dante Controller can typically only discover un-enrolled devices in its local IP subnet. To
connect devices in another subnet to DDM, first connect Dante Controller to the relevant subnet,
and then repeat the process above.
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0 Note: You can also use this function to inform your devices about a known DDM server address
before DDM becomes online in your network.

Virtual Devices

DDM supports the sharing of audio between domains using the concept of 'virtual' devices.

A virtual device is a 'projection’ of a real device, which can appear in multiple domains simultaneously,
and can be subscribed to by real devices in those domains. It presents in Dante Controller as an
independent transmitter, but is really just a logical entity which acts as a subscription proxy for a real
device.

Virtual devices are instantiated when real devices are shared between domains using DDM. They
cannot be created using Dante Controller.

Using DDM, you can control the domains in which a virtual device appears, and which channels on the
real device are exposed by the virtual device. Virtual devices can be assigned their own individual
device names.

In Dante Controller, virtual devices are represented using green device names. The number of transmit
channels they present is dependent on the number of channels that have been shared on the real
device (using DDM).

L) 47 @ | o @& [H &

! Device Info Clock Status  Metwork Status  Events
+ [ [1
] A=
=) —_
@Dante -FEEEEE

5 % T
e =
Filter Transmitters PR
i ﬁ O =
2 48t
= o =
= U
Filter Receivers E a
=
m "
= c
- =]
o A
= =
m r

=

+

+||—| Dante Receivers

+ Desk-Monitors +| [ [+
+ PCle-080690 H [+

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -106-



Dante Controller User Guide /ﬁi Ud i nate®

When you subscribe to a virtual device, the audio you receive is from the real device. Virtual devices
cannot subscribe to other devices.

0 Note: The usual configuration options are disabled for virtual devices.

Legacy Devices

Devices with some legacy (pre-v4.0) versions of firmware can be 'associated' with domains using DDM.
This adds them to the relevant clock domain, and allows them to exchange audio with devices enrolled
in the same domain, which are also on the same IP subnet (legacy devices do not support audio routing
between subnets).

When legacy devices are associated with a domain, they only appear in Dante Controller when you are
logged into the relevant domain (unless they have been specifically revealed - see Hidden Legacy
Devices below).

0 Note: Dante Controller must be connected to the same subnet as a legacy device in order for it to
appear in the Dante Controller interface.

Q Important: When legacy devices are associated with a domain, they are not protected from
unauthorized access via Dante Controller. Also, when associated, they are placed in a dedicated
clock domain and thus can no longer exchange audio with unmanaged devices.

Hidden Legacy Devices
If a legacy device is moved to an unmanaged Dante network without first being de-associated, it will not
appear by default in Dante Controller.

Dante Controller notifies you with a spy icon (next to the network status icons at the bottom left of the
Ul) if you have hidden devices on your network:

Hidden Dewvices 1

To view hidden devices in Dante Controller, select View > 'Show Hidden Devices'.

For more information about legacy devices, see the DDM user guide.
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Domain Credentials

When a device is enrolled in a Dante domain, information about the relevant DDM server and the
domain in which it is enrolled is saved to the device. When the device is unenrolled, the domain
membership information is cleared, and the device returns to the unmanaged (unenrolled) domain.

If an enrolled device is moved out of the DDM network to another network without first being unenrolled,
it will not appear in Dante Controller, because its domain credentials indicate that it is still enrolled in a
domain. In these circumstances it is necessary to clear its domain credentials so that it appears as an
unmanaged device in Dante Controller and can be used again.

To clear the domain credentials for a device, it must first be isolated using the same method for resetting
a device lock PIN.

1. Isolate the device.
2. Open the Device View for the device.

3. From the Device menu, select Clear Domain Credentials.
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Presets

Dante Controller supports the saving and loading of Dante network routing and device configurations,
known as 'presets'. A preset file contains configuration and routing parameters for some or all of the
devices in the network.

Preset files are saved as xml, and can be edited offline. They are also 'device-agnostic' - they can be
shared between networks with different physical devices.

You can use presets to:
= Backup and restore network configurations
= Quickly switch between saved network configurations
= Copy a Dante network configuration from a 'lab' or test network to a live or production network

= Create network configurations for special, or periodic events, and then switch back to the standard
configuration when desired

= Quickly apply one or more configuration settings to a number of devices simultaneously - for
example, setting all devices on your network to the same sample rate (global configuration)

= Use Dante Controller as an off-line editing tool - off-line edit the saved preset configuration for
reuse in new network configuration deployments

About Device Roles

Presets introduce the concept of 'device roles'. When a preset is saved, the configuration and routing for
each selected device is saved into the preset as a device role, with the same name as the device from
which it was created.

The role is not 'tied' to its originating device. When a preset is loaded into Dante Controller, each role
can be applied to its originating device, orto another device (even if it does not support exactly the same
functionality). It is a transferable set of device configuration and routing parameters.

For example:

Dave the sound engineer has gigs on Friday and Saturday night at a local venue. On Friday
evening before the gig, he sets up his Dante network at the venue, and when he's happy with it,
he saves the preset.

After the gig, Dave's annoying boss turns up and steals the mixing console for another job.
Dave, however, has a friend with a similar console (conveniently from the same manufacturer,
and with a higher channel count) which he can borrow for Saturday's gig.

The next night, Dave simply connects the new mixing console to the network, in place of the old
one, and reloads his preset. The new console is now configured exactly like the old one -
including all of the relevant channel names, and media subscriptions - and the network functions
exactly as before, without any need for further configuration. The gig goes really well, and the
band takes Dave out for dinner.

If a role is applied to a device that is different from the role's originating device - for example, a role for
console model A is applied to console model B - Dante Controller will identify any issues that might arise
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(such as unsupported sample rates) and will display those issues so they can be addressed - or ignored,
if they are not important.

Saving Presets

| = Dante Controller - Save Pres:

Select device to be induded in this preset file Select parameters to be induded in this preset file
rDevices rParameters

- Device Name
DVS v

FOH-Amp Redundancy Configuration
FOH-Console
Lobby-Amp

Monitor-Console Device Preferred Master
PA
PCIe-Record External Word Clodk Setting
Stagebox-1
semele Rate Pulle

Device Sample Rate

Device Switch YLAN

Device Encoding
Device Unicast Latency
HaRemote Bridge Mode
Interface IPv4 Addresses
Tx Channel Labels
Tx Flows
Rx Channel Names
Rx Channel Subscriptions

[ Save H Cancel ][ Advanced ]

To save a Preset that includes all device parameters:

w

2. Select the devices that you wish to include in the preset.

1. Click the ‘Save Preset’ button in the main toolbar:

Click All to select all devices, or None to clear all selections.
3. Click Save.

To save a Preset that includes a selection of device parameters:

Click the ‘Save Preset’ button in the main toolbar.

Click Advanced.

Select the devices that you wish to include in the preset.

Select the parameters that you want to save for the selected devices.
Click Save.

a bk w0 b=

Presets are saved as an xml files, which can be manually edited if required, using a text editor.

Parameter Rules

Rx Subscriptions

If ‘Rx Subscriptions’ are included in the preset, and applied to the target system (i.e. ‘Rx Subscriptions’ is
checked in the Advanced > Parameters column when the preset is saved, and also checked in the

Copyright © 2022 Audinate Pty Ltd. All rights reserved. -110-



Dante Controller User Guide /ﬁi Ud i nate®

Preset Elements column when the preset is applied):

All subscriptions for all matched devices on the target system will be updated to match the source
system. This means that:

= All subscriptions saved into the preset will overwrite the respective subscriptions for matched
devices on the target system. If the subscriptions are identical, they are maintained.

= Any existing subscriptions on the target system that do not exist in the preset will be removed,
regardless of whether any subscriptions are defined in the preset.

Tx Flows (multicast flows)
The behaviour for TX Flows and Tx Channel Names is different to that of Rx Subscriptions.

If Tx Flows’ are included in the preset, and applied to the target system (i.e. ‘Tx Flows’ is checked in the
Advanced > Parameters column when the preset is saved, and also checked in the Preset Elements
column when the preset is applied):

= All Tx flows saved into the preset will overwrite the respective Tx flows for matched devices on the
target system.

= Any Tx flows on the target system that do not exist in the preset will be removed, if at least one Tx
flow is defined in the preset. Otherwise (i.e. if no Tx flows are defined in the preset), all Tx flows on
the target system are maintained (note this is different to how Rx subscriptions are handled).

= Multicast flows and/or transmit channel names can be manually deleted from the target device
prior to or following the preset application.

Tx Channel Names
The behaviour for Tx channel names is identical to the Tx flows behaviour described above.

Applying Presets

To load and apply a saved preset, select File > Load Preset from the main menu (Ctrl + L).

Legacy preset files are supported.

The 'Apply Preset' dialogue is arranged in 4 columns, representing the logical steps in applying a preset
(from left to right).

) Apply Preset

Device parameters

o b upeiated 2 Device Roles in this preset - Doy bout th
Name [ FOH-Console 9 Monitor-Console does not support sample rate 24
Rediadoncy Configuraton | | S

[ Stagebox-1

Switch VLAN ] Stagebox-2
Preferred Master
External Word Clock Setting

Sample Rate Pullup

Interface [Pv4 Addresses
[¥] Tx Channel Labels

i sdectal | [ selectione | [ ApplyRoie ] it
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Preset Elements

Use the Preset Elements column to select the parameters that you wish to apply from the preset to the
target network.

-Preset Elements

Redundancy Configuration
Switch VLAN
Preferred Master
External Word Clock Setting
Sample Rate Pullup
Sample Rate
Encoding
Device Latency
HaRemote Bridge Mode
Interface IPv4 Addresses
Tx Channel Labels
Tx Flows
Rx Channel Names
Rx Channel Subscriptions

| All || Mone |

If the target network is not identical to the original network (from which the preset was saved), some
elements might not be applied successfully. For example, if some devices on the target network do not
support the same range of sample rates as the devices on the original network, you could choose not to
apply the 'Device Sample Rate' element, and change the sample rates manually instead, once the
preset has been applied.

Preset Roles

The Preset Roles column lists the roles that were saved in the preset.
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—Preset Roles

|:| D5P-Processor -

[L] FOH-Amp
|| FOH-Console

|| stagebox-2

You can apply a role to the same physical device from which it was created (if it exists in the target
network), or to a different device in the same network, or to another device in a new network.

When a role is applied to the same physical device, or a device of the exact same model, the
configuration and routing should be replicated perfectly (although some subscriptions may be 'broken’, if
the relevant transmitters are not also present on the target network).

0 Note: This makes presets an ideal way to backup and restore configurations for relatively static
networks.

If a role is applied to a different device model or a different type of device, the configuration and routing
may not be replicated exactly - the success of the role assignment will vary depending on the
functionality and channel support of the target device.

Applying a role to a fundamentally different type of device may not be very successful. For example,
applying a role for a fully-subscribed 32-channel mixing console configured at 96kHz to a 2-channel
amplifier that only supports 48kHz will be problematic - only two channels can be subscribed (assuming
the transmitters are also present), and the sample rate will be rejected.

You can apply a role to multiple devices. You cannot apply multiple roles to one device.

To see which devices a role has been assigned to, click the role. The assigned device/s will be
highlighted in the "Target Devices' column.

Automatic Assignments
Dante Controller will automatically assign roles to devices, based on the following rules:

= [fthere is a perfect device match (i.e. the physical device in the original network from which the
role was created is also found in the target network), the role is assigned automatically

= [fthere is a device name match, the role is assigned automatically
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= |f a perfect match or a device name match cannot be made, the role will be assigned automatically
to a device of the same manufacturer and model, assuming there is an unassigned device of that

type
Removing Assignments

To remove an assignment, select the target device and click Clear or press the Delete key on your
keyboard.

Manual Assignments
To manually apply a role to a device:
= Drag the role onto the device, or:

m  Select the role in the 'Preset Roles' column and the target device/s in the 'Target Devices' column,
and click Apply.

The LED icons against each role indicate the assignment status of the role.
[—] A grey icon indicates that the role has not been assigned to any target devices.
D A green icon indicates that the role has been successfully assigned to one or more target devices.

An amber icon indicates that the role has been assigned to one or more target devices, but there is
a warning condition associated with one or more of the assignments.

; A red icon indicates that the role has been assigned to one or more target devices, but there is an
error condition associated with one or more of the assignments.

i A black icon indicates that the role has been assigned to a target device, but the assignment will
have a potentially terminal effect on the operation of the network. A preset cannot be applied if any
terminal issues are identified.

Target Devices

The Target Devices column lists the device names of devices on the currently connected Dante network,
and the roles that have been assigned to them (if applicable).
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-Target Devices

FOH-Console = FOH-Console [ =

Stagebox-1 = Stagebox-1 |:]
Stagebox-2 = Stagebox-2 [

Select All ” Select None H Apply Role H Clear ]

The LED icons against each device indicate the assignment status of the device.
D A grey icon indicates that the device has not been assigned a role.
|:| A green icon indicates that the device has been successfully assigned a role.

[—] An amber icon indicates that the device has been assigned a role, but there is a warning condition
associated with the assignment.

i A red icon indicates that the device has been assigned a role, but there is an error condition
associated with of the assignment.

i A black icon indicates that the device has been assigned a role, but the assignment will have a
potentially terminal effect on the operation of the network. A preset cannot be applied if any terminal
issues are identified.

Issues

The Issues column lists all issues identified by Dante Controller. Clicking a role or a target device will
highlight the issues associated with that role or role assignment.
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-lssues

PA does not support sample rate configuratiofis

PA does not support unicast latency 1 msec

PA does not have enough interfaces for all pr
PA does not have enough transmit channels

PA does not have enough receive channels

The following are 'terminal’ issues that could render the network unusable (identified by a black
LED icon):

= You cannot apply the same device name to multiple devices.

= You cannot apply the same static IP address to multiple devices.

Other issues may or may not be a problem, depending on your requirements for the network.

Applying the Preset

To apply the preset, click OK. Click Cancel to abandon the operation.

Global Configuration
You can use the Presets feature for global configuration, i.e. applying one or more configuration settings
to a number of devices simultaneously.
For example, if you want to apply the same sample rate to all devices on your network:
1. Setone of your devices to the required sample rate.

w

Click None, then select only the relevant device.

Click Advanced.

Click None, then select the 'Device Sample Rate' checkbox.
Click Save.

Load the preset (File > Load Preset).

Click the Save Preset button

© N o g bk~ w Db

In the 'Preset Roles' column, select the relevant role.
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9. Inthe 'Target Devices' column, click Select All.
10. Click Apply then click OK.

This will set all devices to the same sample rate, but will leave all other device configuration settings
untouched.
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Dante Updater

Dante Updater is a desktop application that allows you to update the Dante firmware and software on
Dante hardware devices. It is installed automatically when you install Dante Controller.

The application is linked to an online database containing firmware update files for products from
multiple manufacturers. When the application is connected to a Dante network, it scans the network and
identifies the firmware versions for each discovered Dante device.

& Dante Updater 1.0.2 - a x
3

HOME LIBRARY HISTORY FAIL-SAFE @ ConcertHall~ &  admin

P UPDATE(S) AVAILABLE

PRODUCT LATEST anTe LATEST
UPDATE DEVICE NAME MANUFACTURER MODEL NAME STATUS PRODUCT DANTE
VERSION VERSION
VERSION VERSION
v » Amp1-CH Weyland D10 Out of date 1.0.1 1.1.0 4.0.1.2 4.1.03
L4 P Desk-CH-Main Cyberdyne T-1000 Out of date 1.0.0 2.0.0 4.1.0.3 4.2.06
U4 P Stagebox-CH Cyherdyne T-850 out of date 124 1.4.0 4.1.0.1 4.1.1.0
U4 P Desk-CH-Mons  Cyberdyne T-1000 Out of date 1.0.0 2.0.0 4.1.03 4.2.06
P AmMp2-CH Weyland D8 Out of date 1.01 1.1.0 4.01.2 4.1.03
P Record-CH Tyrell Corp NEMAA Out of date 2.1.0 243 4.1.1.0 4.1.2.2

P UP-TO-DATE

P CONSULT MANUFACTURER

SELECT ALL CLEAR ALL UPDATE SELECTED DEVICES

If newer firmware for any device is available in the online database, you can update the device using the
online file, or download the firmware file to your local machine for offline use. If firmware is found for
multiple devices in your network, you can choose to update all devices simultaneously.

You can always easily control which devices get updated.

Launching Dante Updater

To launch Dante Updater, click the button in the main toolbar:
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W@l Dante Controller - Network View

r
File Device View Help ’

El:” &‘ E| * [E” |i|| @‘ @J| Primary Leader Clock: =1

Routind Device Info  Clock Status  Network Status  Events

@Dante

Filter Transmitters

]
s
EEE

Ampl-CH

AmpZ2-CH
ord-CH[EE!
Stagebox-CHF

Desk-CH-Main [+
sk -CH-Monitors [+

nitters

If Dante Updater identifies one or more devices on your Dante network for which new firmware is
available, a notification icon is displayed on the Dante Updater button in the main toolbar:

Launch Dante Updater to review the available updates and update the device(s).
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Dante Activator

Dante Activator is a new application that allows you to buy and instantly activate additional Dante
channels for supporting Dante Ready™ devices.

® Cante Actator - o X
{r Home
= Devices
.‘Ef Cart
@Dante
@ Support .
Activator

Choose, buy, upgrade!

Vergion 1.1.0

Language -

@ Login

Dante Activator is installed automatically with Dante Controller. To launch Dante Activator, click the

ﬁl button on the main toolbar:

& Dante Controller - Network View

File Devices View Help

SO = E

i Routing: Device Info  Clock Status  Network Status  Events
=

k-CH-Mai
H-MMonitors
igebox2-CH
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Dante Activator scans the local Dante network for any eligible devices, and displays the available
upgrade options.

=} See audinate.com/activate for more information.
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Troubleshooting

Fanout

About Transmit Flows

Transmit flows are 'streams' of media packets which supply data between devices. Dante devices can
support a finite number of transmit flows, depending on their specific hardware configuration and
firmware version.

Dante supports two types of flows - unicast and multicast.

Unicast flows are used to supply media to specific devices, and support up to 4 channels of audio
simultaneously, or 1 channel of video. So if you subscribe 4 audio channels on a receiver to 4 audio
channels on a single transmitter, that audio data will be supplied using one flow. If you were to then
subscribe a fifth audio channel, a second flow would have to be created.

If you were to subscribe 4 different receivers to the same audio channel on a single transmitter, Dante
Controller would have to create 4 unicast flows, because the audio data is going to 4 different places. In
this case, it would be better to create a multicast flow.

A multicast flow 'broadcasts' media across the network, so multiple receivers can subscribe to the
media, but the transmitter is only using one of its available flows. Multicast flows can be configured with
up to 64 channels (depending on the Dante device type). However, multicast media traffic can
propagate throughout an entire network, using up bandwidth on every link in the network. 100Mbps links
in particular are easily saturated when large numbers of multicast flows exist (and would be
overwhelmed by 1 channel of video). Therefore, multicast flows should only be used when there is a
good reason to do so.

@ Note: IGMP snooping must be enabled on network switches that will be carrying Dante video on
1Gbps network infrastructure. Refer to your switch manufacturer's documentation for information
about enabling IGMP snooping.

If you subscribe a number of devices to one channel via unicast, Dante Controller will alert you with the
following message: “Fanout Configuration detected.”

If you then exceed the supported number of transmit flows, any further subscriptions will fail, and the
tooltip for the failed subscription will read 'No more flows (TX): transmitter cannot support any more
flows, reduce fan out by unsubscribing receivers or switching to multicast.'
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Error Message

audinate

Meaning & Actions

'Dante Controller was unable to connect to the
Dante Control and Monitoring manager. Dante
Controller cannot function without this connection.
This problem is most likely caused by the Dante
Control and Monitoring (‘conmon') service or
daemon stopping unexpectedly. Click OK to restart
Dante Controller. You may also need to manually
restart the Dante Control and Monitoring service,
or the computer, if the problem reoccurs.'

'"The installed version [x] of the Dante Control and
Monitoring service (‘ConMon’) is out of date.

This version of Dante Controller requires ConMon
version [x] or later.

Please reinstall Dante Controller to resolve this
issue. Dante Controller will now exit.'

"The installed version [x] of the Dante Discovery
service is out of date.

This version of Dante Controller requires Dante
Discovery version [x] or later.

Please reinstall Dante Controller to resolve this
issue.

Dante Controller will now exit.'

Affects: Windows only.

Meaning: The 'Dante Control and Monitoring'
service is not responding. This can occur after a
computer has been in sleep mode.

Action: Restart Dante Controller. In the event that
does not work, reboot your PC, or restart the Dante
Control and Monitoring service via Control Panel >
Administrative Tools > Services.

Affects: Windows and macOS.

Meaning: Usually this is because the required
service (ConMon) that is installed with Dante
Controller has been overwritten with an older
version by another Dante software product
installation.

Action: Reinstall Dante Controller. This will update
the ConMon service to the latest version.

Affects: Windows only.

Meaning: Usually this is because the required
service (Dante Discovery) that is installed

with Dante Controller has been overwritten with an
older version by another Dante software product
installation.

Action: Reinstall Dante Controller. This will update
the Dante Discovery service to the latest version.

Computer Configuration Checklist

Before installing Dante Controller, you must be logged in to your computer as a user with administrator

privileges.

To be correctly configured for use with a Dante network, the computer should have:

= Dante Controller installed
®  The correct network interface/s selected

® The correct IP addresses in use

Third-party firewall configuration

= Standard Windows and Mac firewalls are typically configured on installation.

= Third party firewalls will need to be manually configured.

If your computer has a third-party firewall installed, please read the Dante Controller and Dante Virtual
Soundcard User Guides for detailed information about firewall requirements and configuration.
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Troubleshooting Dante IP Address Configuration

All devices in a Dante network, including Dante Virtual Soundcard, must be using IP addresses from the
same network. When using Dante Virtual Soundcard or Dante Controller, your PC or Mac must be
connected to the Primary and/or Secondary Dante network, and must have a correct IP address.

@ Note: If a device name is shown in red, it means Dante Controller has automatically detected an
error condition, such as an IP address configuration issue, or the device has entered failsafe.
Double-click the red device name to see more information.

Correct IP configuration
Dante hardware devices are set to obtain their IP address automatically from the network. They will
either:

= Automatically assign themselves an address in the range 169.254.*.* (172.31.*.* for the secondary
network if present), or

= QObtain an IP address from a DHCP server if it is present on the network
Your PC or Mac TCP/IP network configuration set should be set to 'Obtain an IP address automatically'.
This way it will automatically acquire a Link Local automatic IP address in the same network as other

Dante devices. If a DHCP server is present, the computer and Dante devices will all acquire their IP
addresses via DHCP.

Possible IP network configuration mistakes

Possible network configuration errors are listed below. Dante Controller will try to automatically detect
these. If detected the offending device will be displayed in red.

Incorrect PC/Mac IP configuration
= Accidentally having multiple network interfaces with addresses in the same subnet

= |f your secondary network is using Link Local (no DHCP server), all devices on that network will be
in the 172.31.*.* range. The secondary network interface for the computer must be manually con-
figured (using static IP addressing) to the same range.

Incorrect general IP configuration
= Accidentally having multiple DHCP servers on the same network

Unusual - for example, someone may have a PC connected to the network with a DHCP server
running that they’re not aware of.

= |ncorrectly configured static IP addresses

You shouldn’t typically need to configure static IP addresses at all. If for some reason you do, it
must be in the same subnet as the rest of the network.

Incorrect redundant network configuration

Setting up a redundant network is described in 'Routing Audio'. There are a few ways to incorrectly
configure a redundant network. More than one of these can be present at the same time.

= Connecting the secondary interface of a Dante device to the primary network
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Most commonly by either misunderstanding how redundancy works, and using only one switch
with all cables connected to it; or correctly using two switches or networks, but accidentally
connecting one secondary cable to a primary network switch

= Joining the primary and secondary Dante networks

By connecting primary and secondary switches, or perhaps just using one switch.

= Multiple interfaces on the same device using the same IP address subnet
Possibly by having the same DHCP server on both primary and secondary networks, or both
DHCP servers configured to serve the same IP addresses. Also, mixing DHCP and Link Local

on the same network can cause issues. It is often necessary to have all devices and the
computer on either DHCP or Link Local.

What are the symptoms of using the wrong network interface on my
computer?
If you have more than one wired network interface, and Dante Controller is not using the interface the
rest of the Dante devices are connected to:

= Dante Controller cannot see any Dante devices

= Dante Virtual Soundcard is not sending or receiving any audio when it is expected to

How do | check which network interfaces Dante Controller is using?

= The selected network interfaces can be viewed or changed via the 'interface selection' button

—
H®E/in the Network View toolbar of Dante Controller.

& Configure Dante Interfaces in Unmanaged mode x

Select the network interface that the Dante Controller
will use to communicate with other Dante devices (in unmanaged mode):

Use shared Dante interface

Ethernet 1 ~
IP: 10.13.10.201
MAC: 74:D4:35:19:F5:RE

Primary Interface:

"""" Ethernet 2 ~
Secondary Interface: 1G IP: 192.168.30.18
Lol MAC: 80:1F:02:D6:3F:3F

Ok

m [f the Dante network is standalone and does not have a DHCP server installed, the addresses
should be in the range 169.254.*.*

= |f the Dante network is using a DHCP server, the IP addresses should conform to the addressing
scheme it is using (as shown in the image above)

How do | check IP addresses for all devices on my network?

= Use the Device Info tab to view the IP addresses of all the devices on your network.
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Routing Device Info | Clock Status  Metwork Status  Events

~

Device Model Product Dante Device Primary Primary Secondary Secondary
Name Name Version Version Lock Address Link speed Address Link Speed
DANTEAV-Rx DanteAV RY 4.3.0 43.2.1 I:‘ 192, 168.30.27 1Gbps I

DANTEAV-Tx DanteAV TX 4.3.0 43.2.1 I:‘ 192,168.30.28 1Gbps

= The Primary Address of all devices should follow the same IP address scheme (e.g. 169.254.*.* or
10.12.0.*). Same for secondary addresses...

= Note that some older Dante devices or devices running older firmware may not show this inform-
ation.

Troubleshooting Switch Configuration and Cabling

Cables are the most vulnerable part of a network system. If you suspect cabling issues, check for:
= Faulty or manually terminated cables
= Unplugged /badly connected Ethernet cables
= |ncorrectly configured switches

® Dante devices removed or turned off

Symptoms of switch or cabling issues

= You cannot see (some) devices in the Dante Controller network view

= Dante Controller shows orange “unsuccessful subscription” icons, which usually means a device
that was present earlier is now missing

= Faulty cables can lead to intermittent faults, which may be heard as dropped samples or “cracks”
in the audio

= Dante devices may appear and disappear in Dante Controller

Switch and Cabling Checklist

= Are all the connected link/status lights on the switch lit, or flashing as expected?
° |s the switch powered on?
° Is the cable correctly plugged in at the switch and the PC or equipment?
= |s the switch correctly configured?
° Perhaps QoS or VLANs have been incorrectly set up
= Are you using a switch from another application with an unchecked or tested configuration?

° Consult the switch manual and check the switch configuration

0 Note: Video (Dante AV) devices require at least 1Gbps ports and cables.
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Appendix

Resolution and Timing for Dante AV Devices

This is a description of how video resolutions and timings are negotiated between the HDMI source
attached to a Dante AV Tx endpoint (transmitter) between the Dante AV Tx and Rx endpoints, and the
Dante AV Rx endpoint (receiver) to the HDMI sink/display.

Automatic Operation

Resolution and timing configurations can be set to Auto on the Dante AV transmitter. In this case, when
a source device, such as a camera, computer, or BluRay player, is connected via the input HDMI port to
the Dante AV transmitter, the Dante AV transmitter provides the complete list of supported resolutions
and timings to the source device using EDID (Extended Display Identification Data). The source device
then selects one of the available resolutions and timings from the list and initiates sending a signal.

EDID
list Dante AV Device
5 [ Source-selected
M resolution / /_\ e
5 timing ~ \
=> / Dante network \
= ]
HDMI source l v \ °//
Selected
resolution /
timing

Figure 3 - Dante AV HDMI Encode (Auto)

Based on the incoming signal resolution and timing, the network connection between the Dante AV
transmitter and Dante AV receivers is configured. The codec will compress video to match the source
EDID resolution and timing.

It is entirely up to the source device to select the input video resolution based on the available EDID list
presented by the Dante AV transmitter. The Dante AV transmitter provides 49 different resolution and
timing settings.

On the receive end, the Dante AV receiver requests the EDID from the sink/display device attached to
the output HDMI port. It then compares the available resolutions and timings to the subscribed Dante AV
transmitter. Where possible, the signal is decoded and passed at native resolution (the same resolution
and frame rate as the source). However, if the EDID of the sink/display only provides resolutions lower
than the source, the video will be downscaled to match the capabilities of the sink/display. There is no
upscaling available with Dante AV receivers.
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m
=4
Q

Dante AV Device list

—_ Source-selected |
/ ~__ resolution / timing

from Tx device

ICTTTRY
LTI

<

_r Sink / display

Downrscale from |

source resolution
to sink resolution

Best available
resolution /
timing

Figure 4 - Dante AV HDMI Decode (Auto)

The Dante AV receiver is capable of downscaling the following:
= 4096x2160p to 3840x2160p
® 3840x2160p to 1920x1080p
= 1920x1080p to 1280x720p

The frame rate, or timing, of a video signal transported over Dante AV cannot be modified. At present, if
the source provides a 60fps signal into the Dante AV transmitter, then all sinks to Dante receivers must
be capable of supporting 60fps. Frame rate will generally be favored over resolution.

For instance, if the source is providing a 3840x2160p60 input to the Dante AV transmitter, and the sink
device (for example, a display monitor) attached to a Dante AV receiver can only support
3840x2160p30, you might get 1920x1080p60 as the output.

If the frame rate is not supported by the sink device attached to the Dante AV receiver, then no signal will
be passed.

Manual Operation

Using Dante Controller, you can manually set the input resolution, frame rate, color bit depth, and
chroma subsampling for the Dante AV transmitter. By doing so, you will limit the EDID list of supported
resolution and timings to only the manual settings. The HDMI source will need to support whatever
setting is made. The codec/network transmission will follow the input EDID settings made using Dante
Controller.
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Figure 5 - Dante AV HDMI Encode (Manual)

After you save your resolution and timing settings using Dante Controller to the Dante AV transmitter,
the Hot Plug Detect channel on HDMI is toggled off and on in order to initiate an EDID renegotiation with
the source. Itis up to the source to detect the Hot Plug Detect signal and initiate renegotiation using the
new EDID list and select the appropriate input resolution and timing.

On the Dante AV receiver, the function is identical to automatic mode.
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Figure 6 - Dante AV HDMI Decode (Manual)
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